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Safety

Read these simple guidelines. Not following them may be
dangerous or illegal. Read the complete user guide for further
information.

SWITCH ON SAFELY
Do not switch the device on when wireless phone
use is prohibited or when it may cause interference
or danger.

ROAD SAFETY COMES FIRST
Obey all local laws. Always keep your hands free to
operate the vehicle while driving. Your first
consideration while driving should be road safety.

INTERFERENCE
All wireless devices may be susceptible to
interference, which could affect performance.

SWITCH OFF IN RESTRICTED AREAS
Follow any restrictions. Switch the device off in
aircraft, near medical equipment, fuel, chemicals,
or blasting areas.

QUALIFIED SERVICE
Only qualified personnel may install or repair this
product.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do
not connect incompatible products.

WATER-RESISTANCE
Your device is not water-resistant. Keep it dry.

About your device
The wireless device described in this guide is approved for
use on the (E)GSM 850, 900, 1800, 1900, and UMTS 900, 1700,
2100 networks. Contact your service provider for more
information about networks.

Your device may have preinstalled bookmarks and links for
third-party internet sites and may allow you to access third-
party sites. These are not affiliated with Nokia, and Nokia
does not endorse or assume liability for them. If you access
such sites, take precautions for security or content.
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Warning:
To use any features in this device, other than the alarm clock,
the device must be switched on. Do not switch the device on
when wireless device use may cause interference or danger.

When using this device, obey all laws and respect local
customs, privacy and legitimate rights of others, including
copyrights. Copyright protection may prevent some images,
music, and other content from being copied, modified, or
transferred.

Make back-up copies or keep a written record of all important
information stored in your device.

When connecting to any other device, read its user guide for
detailed safety instructions. Do not connect incompatible
products.

The images in this guide may differ from your device display.

Refer to the user guide for other important information about
your device.

Network services
To use the device you must have service from a wireless
service provider. Some features are not available on all
networks; other features may require that you make specific
arrangements with your service provider to use them.
Network services involve transmission of data. Check with
your service provider for details about fees in your home
network and when roaming on other networks. Your service
provider can explain what charges will apply. Some networks

may have limitations that affect how you can use some
features of this device requiring network support such as
support for specific technologies like WAP 2.0 protocols (HTTP
and SSL) that run on TCP/IP protocols and language-
dependent characters.

Your service provider may have requested that certain
features be disabled or not activated in your device. If so,
these features will not appear on your device menu. Your
device may also have customized items such as menu names,
menu order, and icons.

Shared memory
The following features in this device may share memory:
bookmarks; image, audio, and video files; notes, sketch, and
other files; contacts; e-mail messages; and applications. Use
of one or more of these features may reduce the memory
available for the remaining features. If your device displays
a message that the memory is full, delete some of the
information stored in the shared memory.
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Set up your device

Insert the SIM card and battery
Always switch the device off and disconnect the charger
before removing the battery.

Important:  To prevent damage to the SIM card, always
remove the battery before you insert or remove the card.

1 To prevent the battery from coming loose, place the
device so that the back cover is facing up.

2 Place your finger in the grip, and lift the back cover up.
You do not need to press a button to release the back
cover.

3 To release the SIM card holder, slide the holder to the left
(1), and lift the right end of the holder up (2). Make sure
that the bevelled corner on the card is facing up, and that
the contact area on the card is facing the connectors on
the device (3). Close the holder (4), and slide it to the right
to lock it into place (5).

4 Align the contacts of the battery with the corresponding
connectors on the battery compartment, and insert the
battery in the direction of the arrow.

5 To replace the back cover, direct the locking catch toward
its slot, and press down until the cover locks into place.
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Insert the memory card

Use only compatible MicroSD cards approved by Nokia for use
with this device. Nokia uses approved industry standards for
memory cards, but some brands may not be fully compatible
with this device. Incompatible cards may damage the card
and the device and corrupt data stored on the card.

The memory card can be safely inserted or removed even
when the device is switched on.

A memory card may be already inserted in the device. If not,
do the following:

1 To prevent the battery from coming loose, place the
device so that the back cover is facing up.

2 Place your finger in the grip, and lift the back cover up.
You do not need to press any button to release the back
cover.

3 To release the memory card holder, slide the holder
towards the battery (1), and lift up the end of the holder
(2). Insert a compatible memory card into the holder (3).
Make sure the contact area on the card is facing the
connectors on the device. Close the holder (4), and slide
it back to lock it into place (5).
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4 Replace the back cover. Keep the device facing down
when replacing the cover. Make sure the cover is properly
closed.

Charge the battery
Your battery has been partially charged at the factory. If the
device indicates a low charge, do the following:

Charge the battery using the charger

1 Connect the charger to a wall outlet.

2 Connect the charger to the micro USB connector of the
device.

3 When the device indicates a full charge, disconnect the
charger from the device, then from the wall outlet.

The indicator light blinks when the device is charging. The
indicator light stays lit when the battery is fully charged.

You do not need to charge the battery for a specific length of
time, and you can use the device while it is charging. If the
battery is completely discharged, it may take several minutes
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before the indicator light starts blinking or before any calls
can be made.

Charge the battery using the USB cable
You can charge your device using a compatible USB device,
for example a computer, when a wall outlet is not available.
You can also transfer data while charging the device.

1 Connect a compatible USB cable between a compatible
USB device and your device.
Depending on the type of device that is used for charging ,
it may take a while for charging to start.

2 If your device is switched on, USB mode options are
displayed. Select Mass storage mode or PC Suite
mode to make sure that your device receives enough
power from USB charging.

The indicator light blinks when the device is charging. The
indicator light stays lit when the battery is fully charged.

If the battery is completely discharged, allow some time for
charging before using your device.

If your device is on and you have many applications running,
the device can consume more power than it receives from
USB charging. Close some of the applications and disconnect
data connections, or use the charger that comes with the
sales package.

Keys and parts

Keys and parts (front)

1 Power key
2 Light sensor
3 Secondary camera lens
4 Proximity sensor
5 Earpiece
6 Indicator light
7 Touch screen
8 Physical keyboard

To ensure proper functionality of the touch screen, remove
the protective film from the device display.

Do not cover the area left of the touch screen with, for
example, protective film or tape.
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Keys and parts (back)

1 Lens cover
2 Camera flash
3 Camera lens
4 Kickstand

Keys and parts (top)

1 Zoom/Volume key
2 Power key
3 Capture key
4 Infrared port

None of the pre-installed applications of your device use
the infrared port, but it enables the development of third
party applications requiring an infrared port. The
infrared port is not IrDA compatible.

Keys and parts (sides)

1 Stereo speaker
2 Micro USB connector
3 Wrist strap eyelet
4 Stereo speaker
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5 Lock switch
6 Nokia AV Connector (3.5 mm)
7 Microphone
8 Stylus

First start-up

Switch the device on
1 Press the power key.

2 If the device asks for a PIN code or lock code, enter it, and
select Done. The preset lock code is 12345. If you forget
the code and your device is locked, your device requires
service for which additional charges may apply. For more
information, contact a Nokia Care point or your device
dealer.

Switch the device off

Press the power key, and select Switch off!.

Tip: You can also switch the device off by pressing and
holding the power key.

Start-up wizard
1 Switch the device on. A welcome note is briefly displayed,

and the start-up wizard opens.
2 The language, region, time and date settings are

displayed. Define the following:

Language  — Slide your finger up or down to scroll
through the list, and select the language.
Region  — Slide your finger up or down to scroll through
the list and, select the region.
Time  — Define the time format by moving the slider to
24 hrs or 12 hrs, and move the hands of the clock to the
correct time with your finger. If you are using the 12-hour
clock, move the slider to AM or PM.
Date  — Set the current date. To do this, slide your finger
up or down on the day, month, and year columns.

3 To accept and save the settings, select Save.

Kickstand

The kickstand is on the back of the device, and when placed
on a flat surface, can be used when you watch, for example,
video clips, or photos.
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Open the kickstand

Stylus

Some functions, such as sketching, may be easier to use with
a stylus than with your finger.

Important:  Use only a stylus approved by Nokia for use with
this device. Using any other stylus may invalidate any
warranty applying to the device and may damage the touch
screen. Avoid scratching the touch screen. Never use an actual
pen or pencil or other sharp objects to write on the touch
screen.

Use accessories

Headset
You can connect a compatible headset or compatible
headphones to your device. Nokia headsets with music
controls can also be used, but the device does not support
the music controls.

Warning:
When you use the headset, your ability to hear outside
sounds may be affected. Do not use the headset where it can
endanger your safety.

Do not connect products that create an output signal as this
may cause damage to the device. Do not connect any voltage
source to the Nokia AV Connector.

When connecting any external device or any headset, other
than those approved by Nokia for use with this device, to the
Nokia AV Connector, pay special attention to volume levels.

Wrist strap
1 Remove the back cover.
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2 Hook a strap behind the clamp and close the back cover.

Introduction

About Maemo software
This device uses Maemo 5 software on Linux. The software is
built for computer-like performance, enabling the running of
multiple applications at the same time, and delivering a wide
range of activities ranging from web browsing to video
recording. Your device supports Maemo Update, which allows
updating the operating system and applications over a WLAN
or packet data connection.

With Maemo software, it is possible to develop your own
applications for your device. To do this, you can use the
Maemo Software Development Kit (Maemo SDK). For more
information on what Maemo software is and how to develop
applications, see maemo.nokia.com.

About the desktop
The desktop is displayed when you switch on the device. It
offers quick access to different features of your device. You
can have up to four desktops. The desktops can be

personalised to have different widgets, bookmarks,
background images, and shortcuts to applications and
contacts.

The desktop contains the following:

1 Application menu
2 Status area
3 Your network service provider (if a SIM card is inserted)
4 Widgets

Switch between desktops
Swipe left or right.
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Search for contacts
Start entering a name, using the physical keyboard.

Open the virtual keypad to make a call
Start entering a phone number on the desktop, using the
physical keyboard. To enter numbers, press and hold , and
press the desired numbers.

Application menu
The application menu displays the available applications.
Select .

Open an application
Select the application you want to open.

Close an application
Select . All unsaved changes and selections are cancelled.

Status area and status menu
Status area

The status area informs of the current status of items that are
relevant across the device. The current time, and battery and
signal strength are displayed. In addition, the status area may
indicate your internet connection status, available updates,
or your active profile.

Status area indicators
General indicators

A clock alarm is active.

The state of device battery, and possible
charging status.
The current signal strength.

Software updates or additional
applications are available.
The Silent profile is active.

Connectivity indicators

, , ,
or 

The current network.

Synchronisation is in progress.
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A USB connection is active.

A packet data connection is active (network
service).
A wireless LAN connection is active.

An ad-hoc wireless LAN connection is
active.
Bluetooth connectivity is active.

A Bluetooth connection with one or more
Bluetooth devices is active.
SIM card not available (card not inserted or
PIN code not entered).
The Offline mode is active.

GPS indicators

The GPS function is active.

The GPS function is inactive.

Content sharing indicators

Sharing is ongoing.

Sharing is pending and needs your
attention.
Sharing is blocked.

Call indicator

A phone call is active.

Availability status indicators

Online

Busy

If the availability status is offline, no indicator is shown in the
status area.
Sound indicators

Your device is connected to wired or
Bluetooth headphones.
Your device is connected to a wired or
Bluetooth headset device.
The FM transmitter is activated.

If a third-party application adds an icon to the status area, it
is placed after the default icons.

Open the status menu
Tap the status area.

The status menu displays, for example, the remaining battery
life, device volume, and Bluetooth connection status. To
change the displayed status, select the respective status
menu item.
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Dashboard
The applications that are currently running can be seen on
the dashboard. The dashboard also displays the notifications
that you have received but have not opened yet, for example,
text and mail messages, as well as missed calls.

Open the dashboard
When you open an application, the  icon changes to the
dashboard icon . Select  to open the dashboard. The
application remains open, and you can return to the
application by selecting it.

Switch between applications
When several applications are open, select  and the
application you want to switch to.

Respond to a notification
1 When you receive, for example, a new mail, instant

message, or text message, a notification is briefly
displayed. You can view the message by selecting the
notification. If you do not select the notification while it
is displayed, the notification remains on the dashboard.
To indicate this, the  icon blinks and then stays lit.

2 To view the notification on the dashboard, select the
notification.

About the touch screen
Touch screen actions

Tap
To select or open an application or other element on the
touch screen, tap it once with your finger.

Select
In this user documentation, opening applications or items by
tapping them once is called "selecting". If you need to select
several items in a sequence, the display texts to select are
separated by arrows.

Drag
Dragging can be used, for example, to scroll up or down a list.
To drag, place your finger on the screen, and slide it across
the screen.
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Swipe
Swiping can be used, for example, to switch between images
in the Photos application. To swipe, slide your finger quickly
left or right on the screen.

Touch screen backlight

Turn touch screen backlight on
The touch screen backlight is turned off after a period of
inactivity. To turn the backlight on, tap the screen. If the
screen and keys are locked, use the lock switch to unlock
them.

Touch screen actions in applications

Open the application menu
Tap the title bar of the currently open application.

Close a dialog
Tap on a blank space on the desktop. All changes and
selections will be cancelled.

Basic use

About your device
Antenna locations
Your device may have internal and external antennas. Avoid
touching the antenna area unnecessarily while the antenna
is transmitting or receiving. Contact with antennas affects the
communication quality and may cause a higher power level
during operation and may reduce the battery life.
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Cellular antenna

Bluetooth and WLAN antenna

GPS antenna

Control volume

Adjust the volume
Use the volume keys.

Tip: You can view the current volume setting, and also adjust
the volume, from the status menu. Tap the status area to
open the menu. Use the volume slider  to adjust
the volume.

Mute sounds
Drag the volume slider in the status menu all the way to the
left.

Adjust call and message tone volumes
Select  > Settings and Profiles.

Notification light
The notification light can indicate the status of your device.
For example, it can inform you about the battery charging
status, and tell you if you have missed a phone call or
received, for example, a mail or text message. You can enable
or disable the notification light for each notification type by
changing the notification light settings.

The colours of the notification light indicate the following:

Application triggered notification light (received text
message, instant message, or mail)
Battery charging
Battery full

Related topics
• See "Notification light settings ", p. 98.
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Protect your device
Lock your device
To prevent unauthorised use of your device, change the lock
code, and set the device to automatically lock after a certain
length of time.

Briefly press the power key, and select Secure device.

Unlock your device

Enter the lock code, and select Done.

Set the length of the timeout period

Select  > Settings and Device lock > Autolock, and
select the length of time.

Change the lock code
1 Select  > Settings and Device lock > Change lock

code.
2 Enter the current code once, and the new code twice. The

default lock code is 12345.

If you tap outside the dialog at any time, the device lock code
is not changed.

Keep the new lock code secret and in a safe place, separate
from your device.

If you forget the device lock code, you must take the device
to a Nokia Care point. To unlock the device, the software must

be reloaded, and all data you have saved in the device, may
be lost.

Lock touch screen and keys
Locking the touch screen and keys prevents accidental
keypresses.

To lock or unlock the touch screen and keys, slide the lock
switch.

Text input
Use the physical keyboard
To use the physical keyboard, slide the touch screen up. When
you use the physical keyboard, the virtual keyboard is
disabled.
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In addition to the character keys, the physical keyboard
contains the following keys:

1 Sym key
2  key
3 Shift key
4 Space key
5 Enter key

6 Backspace key

Enter text
Press the keys on the keyboard.

Switch between character cases
Press the shift key. To enter only uppercase or lowercase
letters, press the shift key twice. To return to normal mode,
press the shift key again.

Enter numbers, additional characters and common
symbols
Press the  key and press the corresponding key to type a
number, character or symbol. To enter only the characters
printed at the top of keys, press the  key twice to lock the
mode. To return to normal mode, press the  key again.

Enter special characters
Press  and the sym key.

Enter accented characters
If you need to add an accent to a letter, press  and the sym
key, and select the accent from the list. Then press the letter
to which you want the accent to be added.

Use word completion
You can also use the word completion feature. The word
candidates are displayed in the text input area. To select a
word candidate, press the right arrow key.
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Use keyboard shortcuts
Press the ctrl key and the character.

Related topics
• See "Word completion and dictionaries", p. 24.
• See "Use shortcuts", p. 24.

Use the virtual keyboard
To use the virtual keyboard, make sure the physical keyboard
is closed, and select a text entry field, the web address field
of the browser, for example. The virtual keyboard needs to
be activated before you can use it.

Activate the virtual keyboard
Select  > Settings and Text input.
Select the Use virtual keyboard check box.

The virtual keyboard keys are as follows:
  — Switch between uppercase and lower case

characters.
  — Enter numbers, additional characters, and common

symbols.
  — Enter commonly used special characters, symbols, and

language character accents.
  — Open the text input menu, which includes editing

options such as Cut, Copy, and Paste . You can also switch
between the input languages, if you have defined them in the
text input settings.

  — Insert a line break.
  — Delete the character to the left of the cursor.

  — Close the virtual keyboard.

Switch between input methods
To switch between the virtual keyboard and the physical
keyboard, slide the touch screen up or down.

Switch keyboard layout
The physical keyboard layout can vary by region, but the
keyboard can still provide two different text input languages
at the same time.

Switch between input languages

Press the ctrl and space keys simultaneously. This also
switches the languages for the virtual keyboard.

Text input settings 
1 Select  > Settings and Text input.
2 Select from the following:

Hardware keyboard layout  — Define the character set used
in the physical keyboard. Changing this setting may lead to
the physical keys not matching the hardware keyboard
layout.
Use virtual keyboard  — Activate the virtual keyboard.
Word completion  — Enable word completion.
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Auto-capitalisation  — Enable auto-capitalisation, to
capitalise the first letter of sentences automatically when
entering text.
Insert space after word  — Insert a space after each
accepted word completion.
1st language  — Select the first language. To select a
dictionary to use for the first language, select Dictionary and
the dictionary language.
2nd language  — Select the second language. To select a
dictionary to use for the second language, select
Dictionary and the dictionary language. When you switch to
the secondary language, the current dictionary for the word
completion feature is also changed.
Use dual dictionaries  — Use both language dictionaries at
the same time.

Word completion and dictionaries
If word completion is activated, the device suggests suitable
endings for the words that you start writing. Word
completion is based on a built-in dictionary. When you enter
characters, the device searches its dictionary for words
starting with these characters.

You can select to use dual dictionaries to allow the device to
search from the dictionary of the second language if it cannot
find a suitable word in the first language dictionary.

The dictionary can learn new words automatically from the
text you have entered. Text entered in password fields is not
saved in the dictionary.

Activate word completion and use dual dictionaries
Select  > Settings and Text input.

Accept a suggested word
Select the suggested word. When using the physical
keyboard, press the right arrow key.

Reject a suggested word
Continue writing the word. With each character, the device
updates its suggestion to suit the characters you have
entered.

Related topics
• See "Text input settings ", p. 23.

Use shortcuts
Here are some of the available keyboard shortcuts in your
device. Shortcuts can make the use of applications more
efficient.

General shortcuts
Ctrl + C Copy text.
Ctrl + V Paste text.
Ctrl + X Cut text.
Ctrl + A Select all.
Ctrl + O Open (if available).
Ctrl + N Create a new item (if available).
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Ctrl + S Save (if available).
Ctrl + Z Undo (if available).
Ctrl + Y Redo (if available).
Ctrl + F Open search bar (if available).
Ctrl + Right
arrow

Move the insertion point to the end of
the word.

Ctrl + Left arrow Move the insertion point to the
beginning of the word.

Web browser shortcuts

Ctrl + N Open a new window.
Ctrl + R Reload the page.
Ctrl + B Open a bookmark.
Ctrl + D Add a bookmark.

Mail shortcuts

Ctrl + Enter Send a message.
Ctrl + R Reply to a message.

RSS Reader shortcuts

Ctrl + R Refresh the feed.

Personalise your device

Edit and personalise the desktop

Open the desktop menu
Tap the desktop, and select  > Desktop menu.

Personalise the desktop
Select from the following:
Add shortcut  — Add an application shortcut to the desktop.
Add widget  — Add a widget, such as Agenda or Location,
to the desktop.
Add contact  — Add a contact to the desktop.
Manage views  — Set which desktops are in use. To switch
between desktops, swipe the current desktop left or right.
Add bookmark  — Add a web bookmark to the desktop.
Change background  — Change the background image.
There are pre-installed background images in the device, but
you can use any image stored in the device, on an inserted
memory card, or in a paired or shared device.

Rearrange items on the desktop
Drag widgets, bookmarks, contacts, or shortcuts.

Move an item from one desktop to another
Drag the item to the left or right until you reach the desired
desktop.
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Remove items from the desktop
Select  on the widget, bookmark, contact, or shortcut.

Related topics
• See "Add the agenda widget to desktop", p. 89.
• See "Add the media widget to desktop", p. 73.
• See "Add shortcuts to desktop", p. 43.
• See "Change the background image", p. 26.

Profile settings 
Select  > Settings and Profiles.

Set the device to vibrate when in the Silent or General
profile
Select Vibrate.

Select the ringing tone and message alert tones
Select Ringing tone, SMS alert, IM tone, or E-mail alert and
the desired tone.

Add a new ringing tone or message alert tone
Select the tone type, Add, the desired tone, and Done.

Select the volume level of tones
Select System sounds, Key sounds, or Touch screen
sounds and the desired volume level.

Adjust the volume of tones
Drag right or left.

Change the background image
You can select a different background image for each desktop
of your device.

1 Swipe left or right to select the desired desktop.
2 Tap the desktop, and select  > Desktop menu >

Change background.
3 Select Add.
4 Browse to the image, and select Done.

The background image of the current desktop is changed.
To change the background image of another desktop, go
to the desired desktop.

Change the device language
1 Select  > Settings and Language & region.
2 Select Device language and the desired language.
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3 Restart the device.

Change themes 
A theme is a set of matching background images, one for each
desktop.

1 Select  > Settings and Themes.
2 Select a theme from the list.

Connect your device

About connectivity
Your device offers several options to connect to the internet
or to another compatible device, PC, or Mac. The available
connection methods are wireless LAN (WLAN) connection and
a packet data connection.

You can enable automatic transfers between WLAN and
packet data connections, to keep your device constantly
online. You can also set your device to ask which connection
to use. When you connect to the internet for the first time
using a packet data connection, the device prompts you to
select whether you want to allow automatic transfer without
further confirmation.

You can also connect to a PC or other compatible device using
Bluetooth wireless technology, or by using a USB data cable.

Related topics
• See "About WLAN", p. 28.
• See "About packet data", p. 31.
• See "Send data using Bluetooth connectivity", p. 34.

• See "USB", p. 35.
• See "Internet connection settings ", p. 33.

Network settings
Your device can automatically switch between GSM and 3G
networks.

In the status area, the current network is indicated with the
following icons:

GSM
EDGE
3G
HSPA

To modify network settings, select  > Settings and
Phone > Network.

Select the service provider's network
By default, your device selects the network automatically. To
select the network manually, select Manual and a network.

Select network mode
Select which network to use. If you select Dual, the device
uses the GSM or 3G network automatically, according to the
network availability, parameters, and the roaming
agreements between network service providers.
For further information, contact your network service
provider.
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Define data roaming settings
Roaming is based on specific roaming agreements between
your network service provider and other network service
providers, to enable you to use network services outside your
home network, for example when travelling abroad.
Always ask is selected by default. A connection is only
attempted when a confirmation note is accepted. If you select
Always allow, all packet data connections abroad are
handled as in the home network.
For further information and roaming costs, contact your
network service provider.

Use a WLAN connection
You can use a wireless LAN (WLAN) data connection to
connect to the internet. Only one connection to one wireless
LAN can be active at a time, but several applications can use
the same internet access point.

About WLAN
To use a wireless LAN (WLAN) connection, it must be available
in the location, and your device must be connected to the
WLAN. Some WLANs are protected, and you need an access
key from the service provider to connect to them.

Note:  In France, you are only allowed to use WLAN indoors.

Features that use WLAN, or that are allowed to run in the
background while using other features, increase the demand
on battery power and reduce the battery life.

Your device supports the following WLAN features:

• IEEE 802.11b/g standard
• Operation at 2.4 GHz
• Wired equivalent privacy (WEP) with keys up to 128 bits,

and Wi-Fi protected access (WPA2-Enterprise)
authentication method. These functions can be used only
if they are supported by the network.

Important:  Always enable one of the available encryption
methods to increase the security of your wireless LAN
connection. Using encryption reduces the risk of
unauthorised access to your data.

Related topics
• See "Create a WLAN connection", p. 29.
• See "Security settings", p. 29.

Operating modes
There are two operating modes in WLAN: infrastructure and
ad hoc.

The infrastructure operating mode allows two kinds of
communication: wireless devices are connected to each
other through a WLAN access point device, or wireless devices
are connected to a wired LAN through a WLAN access point
device.

In the ad hoc operating mode, devices can send and receive
data directly with each other.
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Create a WLAN connection
1 Select  > Settings and Internet connections >

Connections > New > Next.
2 Enter a descriptive name for the connection, and select

Next.
3 The device asks if you want to scan for available WLANs.

Select Yes to start the scan, and select the WLAN from the
Select connection dialog. If a WLAN is hidden, it is
indicated as hidden in the dialog. You can select a hidden
WLAN as any other WLAN connection, if you know the
network name (SSID), and enter it manually.
To enter the values manually, select No, and define the
following:

Network name (SSID)  — Enter the name of the WLAN.
If you create an ad hoc network, ensure that the name of
the network is unique. When you connect to the internet
over a WLAN, the connection is based on this information.
If the field is dimmed and cannot be edited, the scanned
SSID contains characters entered in an unknown
character set, and not in standard character sets (UTF-8)
as the device expects.
Network is hidden  — Select whether the name of the
WLAN is hidden, that is, the network is configured not to
broadcast its name (SSID). If you select this option, your
device actively searches for the hidden WLANs when you
establish an internet connection.
Network mode  — Select Ad hoc or Infrastructure. The
infrastructure mode is used with internet connections.
Security method  — Select the same security method
that is used by your WLAN access point.

If you operate your own WLAN access point, always
enable one of the available encryption methods to
increase the security of your wireless network. Using
encryption reduces the risk of unauthorised access to
your data.

Available WLANs
After the WLAN scan, all available WLANs are displayed with
the following information:

• Connection type, indicated with  (general) or  (ad
hoc)

• Name
• If the WLAN is already saved in your device,  is

displayed
• WLAN signal strength, indicated with 
• Encryption method used, indicated with  (WPA), 

(WEP), or  (none)

Security settings
Select  > Settings and Internet connections >
Connections.

In the connection setup dialogs, enter the encryption keys
depending on the WLAN connection in question. For stronger
security, it is recommended that you use the WPA method, if
possible.
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WEP key
Enter the wireless equivalent privacy (WEP) key. You can
define more than one WEP key, and you can also select the
default key, if that is required by your WLAN.

WPA key
Enter the Wi-Fi protected access (WPA) preshared key. The key
length must be between 8 and 63 characters. Only ASCII
characters are allowed.

WPA with EAP type
Select the extensible authentication protocol (EAP) type from
the following:

TLS (transport layer security) authentication  — Select the
client certificate used for authentication.
PEAP (protected extensible authentication protocol)
authentication or TTLS (tunnelled transport layer
security) — Select an authentication method used inside
PEAP or TTLS and an optional client certificate.

For MSCHAPv2, define a user name and a password. Select the
Prompt password at every login check box, if you want
your password to be always requested when a connection is
created. For GTC, enter your user name. You are prompted for
a response upon connection creation. The client certificates
are optional. For more information, contact your internet
service provider.

Define advanced settings
Select  > Settings and Internet connections >
Connections. Select the connection and Edit. In the last
dialog, select Advanced.

Modify WLAN proxy settings
Enable proxies
1 Select Use proxy.
2 Enter the IP address of the proxy server, or the host name.

The format of a domain name can be
proxy.company.com.

3 Enter the number of the proxy port.

Bypass proxies
If you have domains for which the use of proxies should be
bypassed, select Do not use proxy for, and enter the domain
names for which the proxy is not needed.

Enable automatic proxies
To obtain the IP addresses automatically from the internet
service provider, select the Automatic configuration check
box, and enter the web address of the server in the Web
address field.

IP address settings
Select the IP Addresses tab.

IP address
1 To obtain the IP address for the device automatically

from the server, select Auto-retrieve IP address.
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2 If you want to enter the values manually, contact your
internet service provider for the correct values and for
further information.

DNS address
Domain name service (DNS) is an internet service that
translates domain names such as www.nokia.com into IP
addresses, such as 192.100.124.195.

1 To obtain the DNS address automatically from the server,
select Auto-retrieve DNS.

2 If you want to enter the values manually, enter the IP
addresses of the primary and secondary domain name
servers, if required by your internet service provider.

Other WLAN settings
Select the Other tab and define the following:

WLAN transmission power  — Select how much power the
device outputs during a WLAN connection. The default value
is 100 mW.
Power saving  — Select the power saving level of WLAN
connections.
Ad hoc channel  — Select a channel for ad hoc WLAN
connections.

To only support authentication according to the WPA2
protocol in WLAN connections, select WPA2-only mode.

The available options vary according to the selected
connection type.

Modify EAP settings
The EAP settings are only visible for WLAN connections that
use the EAP authentication protocol.

Enter user name manually
If the user name differs from the user name provided by the
certificate, select the Use manual user name check box, and
enter the user name in the Manual user name field.

Require client authentication
If you want the EAP server to require your device to be
authenticated, select the Require client authentication
check box.

Use packet data connection
About packet data
Your device supports packet data connections (network
service), such as GPRS in the GSM network. In 3G networks,
data connections remain active during voice calls.

To establish a data connection, an access point is required.
To check what access point types are required for particular
services, and for availability and subscription to packet data
connection services, contact your network service provider.

Related topics
• See "Packet data settings", p. 32.

Fast downloading and uploading
High-speed packet access (HSPA, also called 3.5G) is a network
service in UMTS networks that provides high-speed data
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downloads and uploads. When HSPA support in the device is
activated and the device is connected to a UMTS network that
supports HSPA, downloading and uploading data such as mail
and web pages using a packet data connection may be faster.

 in the status area indicates an active HSPA connection.

For availability and subscription to data connection services
and the related costs, contact your network service provider.

Packet data settings
Packet data settings are usually set automatically by the
device, based on your SIM card. If you need to modify the
settings, contact your service provider for details, and do the
following:

1 Select  > Settings.
2 Select Internet connections > Connections.
3 Select the internet connection provided by your network

service provider, and select Edit. Enter the new details.
To enter the password every time you make a connection,
select the Prompt password at every login check box.

Advanced settings
Advanced packed data settings are modified in the same way
as WLAN settings.

Related topics
• See "Modify WLAN proxy settings", p. 30.

Active data connections
In the status area, the active data connections are indicated
with the following icons:

A packet data connection is active.
 or A wireless LAN (WLAN) connection is active.

Note:  The actual invoice for calls and services from your
service provider may vary, depending on network features,
rounding off for billing, taxes, and so forth.

Close connections
Select the status area and a connection, and close the
connection.

Disable wireless connections

Disable connections
Briefly press the power key, and select Offline mode.

Enable connections
Briefly press the power key, and select Normal mode.

Important:  In the Offline mode you cannot make or receive
any calls, or use other features that wireless network or
Bluetooth connection. Calls may still be possible to the official
emergency number programmed into your device. To use the
features, you must first set the device back to normal mode.
If the device has been locked, enter the lock code.
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Internet connection settings 
You can select which connections are used automatically,
define how often connections are scanned for in the
background, and set the device to switch to a saved WLAN
connection when available.

1 Select  > Settings and Internet connections >
Connect automatically.

2 Select whether you want to use WLAN connections, a
packet data connection, or whichever connection is
available.
To select a connection each time you connect to the
network, select Always ask.

3 Select Search interval to define the frequency of
automatic connection attempts. The default value is 10
minutes.

Switch to WLAN when available
Select Switch to WLAN when available, if you want your
device to use a saved WLAN connection instead of a packet
data connection when such WLAN is available.

Bluetooth connectivity
About Bluetooth connectivity
With Bluetooth connectivity, you can make a wireless
connection to other compatible devices, such as mobile
phones, computers, headsets, and car kits.

You can use the connection to send images, video clips, music
and sound clips, and notes, and transfer files from your
compatible PC.

Since devices with Bluetooth wireless technology
communicate using radio waves, they do not need to be in
direct line-of-sight. However, they must be within 10 metres
(33 feet) of each other, although the connection may be
subject to interference from obstructions such as walls or
from other electronic devices.

This device is compliant with Bluetooth Specification 2.1 +
EDR supporting the following profiles: General Access Profile,
File Transfer Profile, Object Push Profile, Generic Object
Exchange Profile, Headset Profile, Hands Free Profile,
Advanced Audio Distribution Profile, and Audio/Video
Remote Control Profile. To ensure interoperability between
other devices supporting Bluetooth technology, use Nokia
approved accessories for this model. Check with the
manufacturers of other devices to determine their
compatibility with this device.

Features using Bluetooth technology increase the demand on
battery power and reduce the battery life.

Related topics
• See "Pair devices", p. 34.
• See "Send data using Bluetooth connectivity", p. 34.

Bluetooth settings 
1 Select  > Settings and Bluetooth.
2 Select from the following:

Bluetooth on  — Activate Bluetooth connectivity.
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Visible  — Allow your device to be found by other
devices. If your device is hidden (not visible), it can only
be connected to by a previously paired device.
My device's name  — Enter a name for your device. This
name will be visible to other Bluetooth devices.

3 Select Save.

Pair devices
Devices with Bluetooth 2.1 and Secure Simple Pairing (SSP)
ability are paired automatically. Ensure that both devices
display the same passcode.

Pair with Bluetooth 2.0 or older devices
1 Your device proposes a passcode automatically. You can

also create your own passcode (1 to 16 digits), and agree
with the owner of the other device to use the same code.
The passcode is used only once.

2 Select  > Settings and Bluetooth.
3 Select Devices > New.

Your device lists the Bluetooth devices that are within
range and not hidden. The devices are indicated with the
following icons:

computer
mobile device
audio or video device
other device

4 Select the device, and enter the passcode. The same
passcode must be entered in the other device.

5 Select Set as trusted device to authorise the device to
connect to your device without your knowledge. Use this
status only for your own devices, such as your compatible
headset or PC, or devices that belong to someone you
trust.

6 Select Pair.

Cancel the pairing
Tap outside the dialog.

Do not pair with or accept connection requests from
unknown devices. This helps to protect your device from
harmful content.

Devices with no display, such as headsets, are connected
automatically after pairing.

Send data using Bluetooth connectivity
Several Bluetooth connections can be active at the same time.
For example, if you are connected to a compatible headset,
you can also transfer files to another compatible device.

1 Open the application where the item you want to send is
stored, and select the item.

2 Select Share or  depending on the view you are in.
3 Select Send via Bluetooth.
4 Select the device to which you want to connect.
5 If the other device requires pairing before data can be

transmitted, a tone sounds, and you are asked to enter a
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passcode. The same passcode must be entered in both
devices.

Receive data using Bluetooth connectivity
When you receive data using Bluetooth connectivity, a tone
sounds and you are asked if you want to accept the data.

Accept the data
1 Select Save.
2 Define a file name and location for the data, and select

Save.

USB connections
USB
1 Connect your device to a compatible device with a USB

data cable.
2 Select the USB mode. You can set the device to interact

with Nokia PC Suite on your compatible PC or to appear
as a mass storage drive in PC, Mac, or other device

3 To view or change the USB mode, or to disconnect the
device, open the status area menu.

In the status area,  indicates an active connection.

Use your device as a modem
You can use your device as a modem, to connect your
computer to the internet.

1 Connect your device to your computer, using the USB data
cable.

2 Select PC Suite mode.

3 From PC Suite, select Connect to the Internet.

The connection may not be displayed on your device. When
connected, you can use your computer to monitor the
amount of data sent and received.

You can only establish an internet connection using a cellular
network, and may not be able to use some of the other
communication features when the device is used as a
modem.

Browse the web

About browser
With the Maemo browser, you can view hypertext markup
language (HTML) web pages on the internet. You can also
view web pages that are designed specifically for mobile
devices. These pages use extensible hypertext markup
language (XHTML).

Select  > Web.

To browse the web, you must have an internet access point
configured in your device.

Important:  Use only services that you trust and that offer
adequate security and protection against harmful software.

Related topics
• See "Define advanced settings", p. 30.
• See "Web settings", p. 40.
• See "Connection security", p. 38.
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• See "Download files", p. 38.
• See "Install add-ons", p. 39.

Open and browse web pages
Select  > Web, and enter the address in the address bar,
or select a bookmark.

To move around a web page, drag in the desired direction,
or press the space key to move down and shift + space to
move up.

Activate hover mode
To move the cursor on the web page, as if using a normal
mouse, activate hover mode. This mode can be used, for
example, on a map, to hover the cursor over a location, to
display information. To activate this mode, drag from the left
of the touch screen onto the screen.  is displayed. To select
an item when hover mode is activated, press the space or
shift key.

Activate manipulation mode
To select text and images, as if using a normal mouse,
activate manipulation mode. When hover mode is activated,
select .  is displayed. To deactivate manipulation mode,
select .

By default, web pages open in full screen mode. To exit full
screen mode, select .

Tip: Use the stylus to open links more easily.

Zoom specific parts of a web page
Double-tap the desired part. To go back, double-tap again.

Zoom a whole web page
Draw a circle clockwise to zoom in or anticlockwise to zoom
out.

Reload a page
Open the menu, and select Reload.

Stop loading a page
Select .

Browse recently visited pages
To access the recent browsing history, select , or drag your
finger from the right of the touch screen onto the screen. You
can also use the backspace key to open the previous web
page.

Search for text on a web page
1 Open the menu, and select Find on page.
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2 Enter the desired text in the search field.

To hide the search bar, select  from the toolbar.

Related topics
• See "Organise bookmarks", p. 37.

Browser toolbar
The browser toolbar helps you select frequently used
functions of the browser. The toolbar is displayed in normal
screen mode and hidden in full screen mode.

Select  > Web. To switch from full screen mode to
normal mode, tap the screen and select .

From the toolbar, select from the following:
  — Open and edit bookmarks.
  — Add a bookmark, add a shortcut to the desktop, or

subscribe to an RSS feed.
  — Stop loading content.
  — View your recent browsing history.
  — Switch from normal to full screen mode.

Organise bookmarks
Add a bookmark
1 Select  > Web.
2 Go to the web page for which you want to add a

bookmark.
3 From the toolbar, select  > Add to bookmarks.

You can change the name of the bookmark and select where
to save the bookmark.

Add browser shortcuts to desktop
With browser shortcuts, you can quickly access bookmarked
web pages.

1 Select  > Web.
2 Go to a page you want to add a shortcut to.
3 From the toolbar, select  > Add shortcut to

desktop.

Import bookmarks
You can import bookmarks to your device from other devices
and computers.

1 To export an HTML file containing bookmarks from
another browser to your device, use the relevant function
of that browser.

2 Transfer the exported file from the other browser to your
device. You can use mail, copy to a memory card, or use
a USB data cable, for example.

3 Select  > Web, open the menu, and select Import
bookmarks and the file.

The imported bookmarks are added to My bookmarks >
Imported bookmarks.

Clear private data
A cache is a memory location that is used to store data
temporarily. If you have tried to access or have accessed
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confidential information requiring passwords, empty the
cache after each use. The information or services you have
accessed are stored in the cache.

1 Select  > Web, and go to a web page.
2 Open the menu, and select Options > Clear private

data.
3 Select from the following:

Browsing history  — Clear the browsing history of web
pages and links you have opened and web addresses you
have entered using the application toolbar.
Cache  — Clear the memory cache. The memory cache is
automatically cleared whenever you close the browser
application.
Cookies  — Clear all cookies.
Saved passwords  — Clear all passwords you have saved
for authentication purposes and web forms.
Authenticated sessions  — Clear all authenticated
sessions.

Connection security
Data transmission between your device and a web server is
encrypted if the secure server information banner is
displayed. The security information includes the address of
the website and the verification.

View security information for a website
Open the menu, and select Details.

Security certificates may be required for some services, such
as banking services. You are notified if the identity of the
server is not authentic or if you do not have the correct
security certificate in your device.

Important:  Even if the use of certificates makes the risks
involved in remote connections and software installation
considerably smaller, they must be used correctly in order to
benefit from increased security. The existence of a certificate
does not offer any protection by itself; the certificate
manager must contain correct, authentic, or trusted
certificates for increased security to be available. Certificates
have a restricted lifetime. If "Expired certificate" or
"Certificate not valid yet" is shown, even if the certificate
should be valid, check that the current date and time in your
device are correct.

Before changing any certificate settings, you must make sure
that you really trust the owner of the certificate and that the
certificate really belongs to the listed owner.

Download files
Important:  Only install and use applications and other
software from sources that you trust. Applications from
untrusted sources may include malicious software that can
access data stored in your device, cause financial harm, or
damage your device.

1 Select  > Web, and go to a web page that contains
download links.

2 Select a link that points to the file that you want to
download.
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3 Select from the following:

Open with  — Open the file in the appropriate
application.
Save to device  — Save the file to your device.

After a file transfer from an internet server starts, the name
and size of the file and the progress of the download is
displayed. Closing the dialog does not interrupt active
downloads.

During the download, you can do the following:
Pause  — Pause the download.
Resume  — Continue the download. You may not be able to
resume all paused files, because not all servers support it.
Delete  — Cancel and delete the download.

Save web pages
You can save web pages to your device, to view them offline.

1 Go to the web page you want to save.
2 Open the menu, and select Options > Save page as.
3 Enter a name, select where to save the page, and select

if you want to save the images also.
4 Select Save.

View browsing history
You can view and visit your most recently visited web pages.
The browsing history contains the web pages you have
visited in the current browser window. The complete

browsing history contains all the web pages you have visited
in the past seven days.

1 Select  > Web, and go to a web page.
2 From the toolbar, select .

Tip: You can also access the recent browsing history by
dragging your finger or the stylus from the right of the
touch screen onto the screen.

3 Select a web page from the recent history, or select
Complete browsing history and the desired date and
web page.

Install add-ons
You can install XPI based add-ons for the browser.

Important:  Only install and use applications and other
software from sources that you trust. Applications from
untrusted sources may include malicious software that can
access data stored in your device, cause financial harm, or
damage your device.

1 Select  > Web, and go to a web page.
2 Open the menu, and select Options > Add-ons.
3 Select the desired installation file.

You can disable or enable add-ons. You may need to restart
the browser.
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Modify browser settings
Adjust view
You can change the way web pages are displayed in the
browser.

1 Select  > Web.
2 Open the menu, and select Options > Adjust view.
3 Select from the following:

Show images  — To load and display all images, select
Always. To display loaded images only, select Only
loaded. To never load or display images, select Never.
Text size  — Define the text size. To display the browser-
defined text size, select Normal. To display 150% or
200% larger text, select Large or Very large.
Encoding  — Text characters may not display correctly
on web pages with different languages. To make a web
page more readable, select the encoding that best
matches the language of the web page.

Web settings
1 Select  > Web, and open a web page.
2 Open the menu, and select Options > Settings and from

the following:

Memory cache size (MB)  — Define the amount of RAM
you want to use as cache.
Enable JavaScript  — JavaScript functionality is used on
many websites. Websites may have malicious scripts and
it can be safer not to run them. Some websites may not
work at all without JavaScript enabled.

Open pop-ups  — To allow all pop-up windows, select
Always. To only allow pop-up windows that you open by
selecting a link, select Only requested. To block all pop-
up windows, select Never.
Enable password saving  — Save passwords for web
forms, on website login pages, for example. When this
option is not selected, passwords are not filled in and you
cannot save passwords. Cancelling this selection does not
delete previously saved passwords.
Accept cookies  — A cookie is data that a site saves in
the cache memory of your device. Cookies contain
information about your visits to websites. They help to
identify you upon subsequent visits and retain
information when you move between web pages. To
accept the use of cookies, select Always. To be prompted
before a cookie is stored, select Ask first. To prevent
cookies from being stored, select Never.
Open initially in Full screen  — Switch to full screen
mode when a new window is opened.
Allow JavaScript pausing  — Suspend the use of Flash
and JavaScript whenever the browser window is open in
the background.

It is recommended that you do not save passwords or use
other similar features in web services or sites where you store
personal data or content. This is especially important if
unauthorised access to such web services or sites could cause
you financial harm.
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Organise your contacts

Add and edit contacts
When you open Contacts for the first time, the Get contacts
dialog opens. You can import contacts from your SIM card,
mobile phone, or other device.

Select  > Contacts. A list of all your stored contacts and
their possible availability status, status message, and avatar
image is displayed.

Add a new contact
1 Open the menu, and select New contact.
2 Enter the contact's first name and last name. Only one

name field is required.
3 Enter a phone number. Define whether it is home or work

number, and mobile or landline.
4 Enter a mail address. Define whether it is a home or work

mail address.
5 To add an avatar image, select the placeholder image.

Select a default avatar, or to use a different image, select
Browse.

6 To add more details, select Add field. You can add details
about, for example, addresses, birthdays, business
details, mail addresses, nicknames, notes, phone
numbers, SIP user names, titles, and websites.

7 Select Save.

You can also manually add contact user names for different
internet services. If you set up your own account, the contacts
are automatically imported from the server.

Edit a contact
1 Select the contact, open the menu, and select Edit.
2 Edit the contact's details.

To add more details about the contact, select Add field.
To remove details, select Delete fields. Select the details
you want to delete and Delete. You cannot remove the
first name, last name, or gender field.

3 Select Save.

Merge a contact
If you have duplicate contacts, do the following:

1 Select the contact, open the menu, and select Merge
contact.

2 Select the contact to merge with.
If the contact details have contradicting information or
the merging was not successful, select the desired details
and Save.

Delete a contact
1 Open the menu, and select Delete contacts.
2 Select the contacts to delete and Delete.
3 Confirm the deletion.

The contacts are also deleted from all possible services.

Related topics
• See "Import and export contacts", p. 42.
• See "Synchronise and transfer content from another

device", p. 80.
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Add and edit My information
My information is a view that contains your own contact
details. You can also access your IM accounts or mail from this
view.

Select  > Contacts, open the menu, and select My
information.

Add My information manually
1 Enter your first name, last name, phone number, and mail

address. Only one name field is required.
Your phone number is automatically imported from your
SIM card if it is available. Other details, such as for internet
call or chat services that you have set up an account for,
may also be automatically imported. You cannot edit
imported details.

2 To add an avatar manually, or change an automatically
imported avatar, select the placeholder image. Select a
default avatar, or to use a different image, select
Browse.
Your avatar is automatically downloaded from the IM
service. If you have more than one service set up, the
avatar is picked randomly.

3 To add more details about yourself, select Add field.
4 Select Save.

In the My information view, the availability icon shows your
availability status, status icon, and status message. To access
the availability settings, select the icon.

Edit My information
1 Open the My information menu, and select Edit.
2 Edit the fields as necessary, and select Save.

Sort contacts
1 Select  > Contacts, and open the menu.
2 Select from the following:

ABC  — Sort the contact list alphabetically.
Availability  — Sort the list by availability status. Your
contacts are listed by availability first, then in
alphabetical order.
Recent  — Sort the list according to recent activity. The
contacts you have recently communicated with are listed
first.

View groups
Open the menu, and select Groups.

View communication history
Select a contact, open the menu, and select Communication
history.

Import and export contacts
You can import contact information from another device, IM
accounts, a SIM card, or from a compatible file.

Import contacts
1 Select  > Contacts, open the menu, and select Get

contacts.
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2 Select from the following:

Synchronise from other device  — Synchronise existing
contacts from another device.
Import contacts from new account  — Modify or create
an IM account. When an IM account is created, the
contacts of that account are imported.
Copy from SIM card  — Copy all contacts from your SIM
card automatically.
Import contacts file  — Import contacts from a file
stored in your device.

You can import contacts from files that have the .vcf file
extension.

Export contacts
1 Select  > Contacts, open the menu, and select

Export. Select Next.
2 Select whether you want to export All contacts or

Selected contacts, and select Next.
If you selected Selected contacts, select the contacts you
want to export, and then select Done.

3 Select the export file format, and select Next.
4 Define the folder name for the exported contacts, select

a location for the folder, and select Next.
5 Select Finish.

Send contact cards
You can send contact cards in a text message or mail, or
through Bluetooth connectivity.

Send a contact card
1 Select  > Contacts.
2 Select the contact whose contact card you want to send.

To send your own information, open the menu, select My
information.

3 Open the menu, and select Send contact card.
4 Select the method to use to send the contact card.
5 Select the contact you want to send the card to, and select

Send.

Send a contact detail
1 Select  > Contacts.
2 Select the contact whose contact detail you want to send,

open the menu, and select Send contact detail.
3 Select the contact detail you want to send.
4 Select the method to use to send the contact detail.
5 Select the contact you want to send the detail to, and

select Send.

Add shortcuts to desktop
You can add shortcuts to contacts on the desktop. To open a
list of available contact methods, select a contact.

Add a shortcut
Select  > Contacts, select the contact you want to add
the shortcut for, open the menu, and select Create
shortcut.

You can only create one shortcut for a contact.
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Synchronise your contacts
1 Select  > Contacts.
2 Open the menu, and select Get contacts > Synchronise

from other device > Next.
3 Select whether you want to transfer data from other

Bluetooth devices, or to set up synchronisation to keep
data updated on both devices. Select Next.

4 Select Select device and the desired device from the list.
5 Enter the identification number of the device you want

to transfer data with, and select Pair.

Related topics
• See "Synchronise content", p. 80.

Contacts settings
Select  > Contacts, open the menu, and select
Settings.

Define how names are displayed
Select Display names. The default order is First name Last
name.

Delete all contacts on the device
Select Delete all contacts from device. The contacts are
removed from the device, but they can still be found on the
server.

Make calls

About calls
You can make voice calls and internet calls with your device.

Tip: You can make a call to a person saved in Contacts using
the physical keyboard. On the desktop, start entering the
name of the person to open Contacts. Select the contact from
the proposed matches, and select .

You can also enter a phone number on the desktop using the
physical keyboard. Press and hold , and enter the number.
In the virtual keypad view, select .

Related topics
• See "Make a call", p. 45.
• See "Internet calls", p. 47.
• See "Options during a call", p. 48.

Proximity sensor
Your device has a proximity sensor. To prevent accidental
selections, the touch screen is disabled automatically during
calls when you place the device next to your ear.
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Do not cover the proximity sensor, for example, with
protective film or tape.

Make voice calls
Make a call
Select  > Phone.

Hold your device correctly during a call.

Select a recipient from the contacts list
Select Select contact and the contact. To search for a contact,
use the physical keyboard to start entering the first
characters of the name, and select from the proposed
matches. If you have saved several numbers for a contact,
select the desired number from the list.
If you hold the device in the portrait orientation, you can use
the initial character icons on the right side of the display to
find your contact.

Select a recipient from the recent calls list
The recent calls are listed in the Phone main view. Select a
contact from the list to make the call.

Enter the phone number manually
Select  and the cellular call type. Enter the phone number,
including the area code.

Enter an international phone number
Select * twice to enter the + character (which replaces the
international access code), and enter the country code, area
code (omit the leading zero if necessary), and phone number.

Make the call
Select .

End the call
Select .

Cancel the call attempt
Select .
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Tip: To add a contact card to the desktop, select Contacts and
a contact. Select the contact's name from the menu and
Create shortcut.

Answer a call

Answer a call
Select . If the incoming call has been diverted from another
phone number, is displayed.

Reject a call
Select .

End an active call
Select .

Mute the ringing tone
Select .

Answer another call during a call
If call waiting (network service) is activated, select  to
answer a new incoming call. The first call is put on hold.

Make a conference call
Select  > Phone.

Conference calls (network service) can only be made over
cellular networks and can have a maximum of three
participants (including yourself).

Call the first participant
Enter a participant's phone number, or select a contact from
your contacts list.

Add an additional participant
Select New call to contact or New call to number.

Start the conference
Select Start conference call.

Talk to a participant privately
Select the participant and Private. This splits the conference
call into two separate calls. To end one of the calls, select the
call and End.

End the conference call
Select End.

Send DTMF tones
You can send dual-tone multifrequency (DTMF) tones during
an active call to control your voice mailbox or other
automated phone services.

1 During a call, select .
2 Enter the DTMF sequence.

You can also enter the tone sequence using the keyboard.
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Make internet calls
Internet calls
Internet calls are based on the voice over internet protocol
(VoIP) that allows you to make and receive calls over the
internet. To use this feature, you must have an active network
connection (WLAN or packet data) and a registered internet
call account with an internet call service provider, and your
availability status must be On to allow you to receive calls.

Internet call services may not support emergency calls.
Contact your internet call service provider for further details.

Related topics
• See "Make an internet call", p. 47.

Create and edit call accounts
With call accounts, you can use internet call or instant
messaging services.

Select  > Phone.

Create a call account
1 Open the Phone menu, and select Accounts > New.
2 Select a service and Register new account.
3 Enter the user details.

You can also create accounts in the Conversations
application.

Sign in to an existing call account
1 Open the Phone menu, and select Accounts and the

account.

2 Enter the user details, and select Sign in.
When an existing account is taken into use, your contacts
are automatically retrieved from the account server and
added to Contacts.

Edit an account
Select an account, and edit your user name, password, or
screen name.

Enable or disable an account
Select an account, and select or clear the Enabled checkbox.

Save account settings
Select Save.

Related topics
• See "Change availability status", p. 51.

Make an internet call
1 Select  > Phone.
2 Connect your device to an internet connection, and select

a VoIP service account. Your availability status changes
to Online.

3 Select Select contact and a contact.
4 To end the call, select .

You can also make an internet call from the Contacts
application.
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Answer an internet call
Select .

Options during a call
Options during an active call
Open the menu, and select from the following:
Hold call  — Put the call on hold.
New call to number  — Call another number to start a
conference call.
New call to contact  — Call a contact to start a conference
call.

Options during a call that is on hold
To put a call on hold, open the menu, select Hold call.

Open the menu, and select from the following:
Activate call  — Activate the call.
New call to number  — Call another number to start a
conference call.
New call to contact  — Call a contact to start a conference
call.

Mute the microphone
Select .

Activate the loudspeaker
Select Speaker.

Send DTMF tones
Select .

End the call
Select End.

The available options may vary depending on the call mode.

Call timers
You can view the duration of received and dialled calls. The
duration of voice and internet calls is displayed separately.

Select  > Phone. Open the menu, and select Call
timers.

Clear call timers
Select Clear timers. Both voice and internet call timers are
cleared.

Emergency calls
Before making an emergency call, switch the device on, and
check for adequate signal strength. If the screen and keys are
locked, slide the lock switch on the side of the device to
unlock them.

Important:  This device operates using radio signals,
wireless networks, landline networks, and user-programmed
functions. Emergency calls can be made using the cellular
phone.It is not possible to make an emergency call using
voice calls over the internet (internet calls). Connections in all
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conditions cannot be guaranteed. You should never rely
solely on any wireless device for essential communications
like medical emergencies.

Make an emergency call
1 Select  > Phone.
2 Select  and the cellular call type.
3 Enter the official emergency number for your present

location.
4 Select  to start the call.

Make an emergency call without entering PIN, PUK, or
lock code
1 When the device asks for the code, enter the emergency

number for your present location. The Emergency
call icon appears.

2 Select Emergency call to make the call. After the
emergency call, you need to enter the required PIN, PUK,
or lock code to be able to use other device functions.

When making an emergency call, give all the necessary
information as accurately as possible. Your wireless device
may be the only means of communication at the scene of an
accident. Do not end the call until given permission to do so.

Send text and instant messages

About Conversations
Select  > Conversations.

In Conversations, you can send text and instant messages.

The services share the main view, where text message and
instant message conversations are listed. Select a
conversation to see the messages in it.

Tip: To call a contact from the conversations main view,
select and hold a conversation to open a pop-up menu. Select
Open contact card, and the call type. The information on the
contact card depends on which details have been added to
it.

Related topics
• See "Text message and instant message

settings", p. 52.

Send text messages
Send a text message
1 Select  > Conversations.
2 Select New SMS.
3 To add a recipient, select To and a contact, or enter a

phone number.
4 Write your message in the message body. You cannot use

the enter key to move to the next row (if you press the
enter key, the message will be sent).
To add a smiley, select the desired smiley.

5 Select Send.

Text messages are displayed in the main view as a
conversations list.

Your device supports text messages beyond the limit for a
single message. Longer messages are sent as two or more
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messages. Your service provider may charge accordingly.
Characters with accents, other marks, or some language
options take more space, and limit the number of characters
that can be sent in a single message.

Forward a text message
1 Select  > Conversations.
2 Select the conversation and then the text message.
3 Select Forward.

Send a contact card
1 Select  > Contacts and a contact.
2 Open the menu, and select from the following:

Send contact card  — Send all the contact details.
Send contact detail  — Send a specific contact detail
only.

3 Select whether the card is sent as a text message, using
Bluetooth connectivity, or as a mail message.

4 Select the message recipient, or enter a phone number.
5 Select Send.

Save a received contact card
1 Select  > Conversations.
2 Open the conversation with the received text message,

and select the contact card link.
3 Select if you want to save the contact card as a new

contact or update existing contact card information.

Send instant messages
Create and sign in to an instant messaging account
To send instant messages, you must create an instant
messaging account.

Select  > Conversations, open the menu, and select
VoIP and IM accounts.

Create an instant messaging account
1 Select New.
2 Select a service and Register new account.
3 Enter your user details. Depending on the service, you

may have to set up an account using a web browser.
Follow the instructions.

Sign in to an existing instant messaging account
Enter your user details, and select Sign in.

When an existing account is activated, your contacts are
automatically fetched from the account server and added to
your contacts list.

Send an instant message
1 Select  > Conversations.
2 Select New IM and a contact, or open the menu, select

Chat with, and enter an instant messaging address.
3 Write your message in the message editor.

To add a smiley, select the desired smiley.
4 Select .
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Save and view instant messaging history
Your instant messaging history is saved automatically.

To view your instant messaging history, select  >
Conversations, and a conversation.

Change avatars
1 Select  > Conversations.
2 Open the menu, and select Accounts and the account for

which you want to change the avatar image.
3 Select Avatar and the desired avatar, or select Browse

to browse your device memory for images.
4 To save the avatar, select Save.

You can also change your avatar by modifying the account
settings.

Related topics
• See "Account settings", p. 51.

Change availability status
Select the status bar, Availability, and from the following:

Online, Busy, or Offline — Set your availability status.
Type your status message  — Enter your availability status
message.
My location  — Define your current location.
New status  — Add a new availability profile. With
availability profiles, you can modify your availability
separately for each account.

Account settings
1 Select  > Conversations.
2 Open the Conversations menu, and select Accounts.
3 Select an account, and define the following:

User name and Password — Enter your user name and
password.
Screen name  — Enter your screen name.
Avatar  — Select an avatar image.
Edit personal info  — Edit your personal information.
Enabled  — Enable or disable the account.

4 Select Save.

Delete messages and conversations
Select  > Conversations.

Delete a text message
1 Select a conversation and a text message.
2 Select Delete.

Delete all text messages in one conversation
1 Open the conversation.
2 Open the menu, and select Clear conversation.

Delete conversations
1 Open the menu, and select Delete conversations.
2 Select the desired conversation or conversations and

Delete.
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Filter conversations
To open the filter bar to find a specific conversation, start
entering search terms using the keyboard. Matching
conversations which include the entered search terms are
displayed in the conversations list view.

Text message and instant message settings
1 Select  > Conversations.
2 Open the Conversations menu, select Settings and from

the following:

Receive SMS delivery reports  — Select whether to
receive text message delivery reports.
SMS centre number  — Use the text message centre
number stored on your SIM card, or define another
number.

3 Select Save.

Mail

About mail
You can access your personal mail accounts from your device,
using Nokia Messaging. You can synchronise your mail from
a single mailbox (default mailbox) or multiple mailboxes.
Nokia Messaging enables push-synchronising to regular IMAP
mail servers, such as Yahoo or Gmail.

You can also access your work mail, using Mail for Exchange.
You can read and reply to mails, view and edit compatible
attachments, and manage your calendar and contact
information.

Related topics
• See "Set up your other mail", p. 53.
• See "Read and send mail", p. 55.
• See "Organise your mail", p. 57.
• See "Modify mail settings", p. 58.

Read your work mail using Mail for Exchange
With Mail for Exchange, you can receive your work mail to
your device. You can read and reply to your mails, view and
edit compatible attachments, view calendar information,
receive and reply to meeting requests, schedule meetings,
and view, add, and edit contact information.

Mail for Exchange can be set up only if your company has
Microsoft Exchange server. In addition, your company's IT
administrator must have activated Microsoft Exchange
ActiveSync for your account.

ActiveSync
Use of the Mail for Exchange is limited to over-the-air
synchronisation of PIM information between the Nokia
device and the authorised Microsoft Exchange server.

Before starting to set up Mail for Exchange, ensure that you
have the following:

• A corporate mail address
• Your Exchange server name (contact your company's IT

department)
• Your network domain name (contact your company's IT

department)
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• Your office network password

Depending on your company's Exchange server
configuration, you may need to enter other information in
addition to those listed. If you do not know the correct
information, contact your company's IT department.

With Mail for Exchange, the use of the lock code may be
mandatory. The default lock code of your device is 12345, but
your company's IT administrator may have set a different one
for you to use.

Set up your mail
Set up a Nokia Messaging account
You can have only one Nokia Messaging account set up in your
device.

1 Select  > E-mail.
2 Open the menu, and select New account
3 Define the following:

Region  — Select your country or region.
Service provider  — Select Nokia Messaging.

4 Define the following mandatory information:

E-mail address and Password — Enter a mail address
and password.

5 Select Finish.

Set up your other mail
To send and receive mail messages, you must have an active
network connection and a mail account with a mail service
provider. For the correct settings, contact your mail service
provider.

Using mail services (for instance, retrieving messages
automatically) may involve transmission of large amounts of
data. Contact your network service provider for information
about data transmission charges.

1 Select  > E-mail.
2 Open the menu, and select New account.
3 For account details, define the following:

Region  — Select your country or region.
Service provider  — Select your mail service provider. If
your mail service provider is not listed, select Other.
Account title  — Enter a title for the account.

4 For user details, define the following:

Name  — Enter your name. This name is displayed in the
sender field of sent messages.
User name and Password — Enter your user name and
password for the mail service. They are needed when you
log into your mailbox. If you leave the password field
empty, you are prompted for a password when you try
to connect to your mailbox on the mail server.
E-mail address  — Enter your mail address. It must
contain the @ character. Replies to your messages are
sent to this address.
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5 If you selected Other as the mail service provider, define
the following settings for incoming mail:

Account type  — Select the mail protocol (POP3 or IMAP4)
recommended by your mail service provider. IMAP4 is
more modern and typically enables more functionality.
Some functionality may be restricted with POP3.

You cannot change this setting after you save the account
settings or exit the wizard.
Incoming server  — Enter the host name or IP address
of the POP3 or IMAP4 server that receives your mail.
Secure authentication  — Set the system to use secure
authentication.

If you do not use secure connections, it is strongly
recommended that you enable secure authentication.
For information on the supported methods, contact your
mail service provider.
Secure connection  — Define the security setting for
incoming messages.

If you access your mail over a wireless LAN (WLAN), it is
strongly recommended that you use secure connections.
For information on the supported secure connections,
contact your mail service provider.

Tip: Usually, the incoming mailbox servers (POP3 or
IMAP4) are provided by your mail service provider, and
the outgoing mail server (SMTP) is provided by your
internet service provider. If these service providers are

different, you may have different passwords and security
settings for incoming and outgoing messages.

6 Simple mail transfer protocol (SMTP) servers are used
when sending mail. To send mail, you must define the
SMTP host name or IP address that you obtain from the
mail service provider of the connection you use.
If you selected Other as the mail service provider, define
the following settings for outgoing mail:

Outgoing server  — Enter the host name or IP address
of the server that sends your mail.
Secure authentication  — Set the system to use secure
authentication.
Secure connection  — Define the security setting for
outgoing messages.
Use connection-specific SMTP servers  — Use
connection-specific SMTP servers for sending mail. To
edit connection-specific SMTP server settings, select Edit
SMTP servers.

Tip: The settings for outgoing mail (SMTP) usually either
use a user name and a password, or are specific to a
connection. Without an SMTP user name and password,
your internet service provider may prevent you from
sending mail for security reasons.

7 To complete the mail account setup, select Finish.

Set up a Mail for Exchange account
To be able to use Mail for Exchange, you need a Mail for
Exchange account.
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To set up an account:

1 Select  > E-mail, open the menu, and select New
account.

2 Define the following:

Region — Select the correct region.
Service provider — Select Mail for Exchange.

3 Define the following:

Mail address — Enter your mail address.
User name — Enter your user name.
Password — Enter your password.
Domain — Enter the domain name. This field is not
mandatory.

4 Define the following:

Server — Enter the server address.
Port — Enter the port number for the Mail for Exchange
server connection. The field is pre-filled with the
standard HTTPS Mail for Exchange port number.
Secure connection — Use a secure connection.

5 On the Synchronisation content page of the wizard,
define the following:

E-mail  — Enable mail synchronisation.
Calendar and tasks  — Enable calendar and task
synchronisation.
Contacts  — Enable contact synchronisation.

First synchronisation  — If you have enabled contact
synchronisation, you need to select if you want to remove
all local contacts when the device synchronises for the
first time. Keep items on device is selected by default.

6 To modify advanced settings, select Advanced
settings.

7 Select Finish.

Read and send mail
Retrieve and read mail messages
Select  > E-mail.

Your device can automatically receive the mail messages sent
to you.

Retrieve mail messages manually
1 Open the menu, and select Send & receive. The

messages are retrieved for all accounts.
If you want to receive messages only from a specific
account, select the desired account, open the menu, and
select Send & receive.
When retrieving mail, all messages in the Outbox folder
are sent.

2 To retrieve the contents of a selected message, select the
message header.

Read a mail message
To open a message, select the header of the message.
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If new mail messages are received while the mail application
is closed, a notification is displayed. To open a new message,
select the notification.

Reply to a received mail message
Select  to reply to the sender, or  to reply to the sender
and the other recipients of the mail message.

Forward a received mail message
Open the menu, and select Forward.

Mark a mail message as read or unread
Open the menu, and select Mark as read or Mark as
unread.

Move to previous or following mail message
Select  or .

Delete a mail message
Select .

Create and send mail messages
1 Select  > E-mail.
2 Select New message.
3 Enter a mail address, or select recipients from the

contacts list.
To separate multiple recipients, add a semicolon (;) or a
comma (,). Use the Cc field to send a copy, or the Bcc field
to send a blind copy to other recipients. If the Cc or Bcc

field is not visible, open the menu, and select Show Cc or
Show Bcc.

Tip: You can also view the mail addresses of recipients.
To do this, enter the recipients' names, open the menu,
and select Check names.

4 Enter the subject, and write the message. To change the
font face, size, and colour of text in the message, select
the icons from the toolbar.

5 Select .

Message settings
You can define a priority level for your mail message, and
define whether the message is sent as formatted text (HTML)
or plain text.

When writing a message, open the menu, and select
Message settings.

Define the priority level
Select Low, Normal (default), or High.

Define the text format
Select Formatted text (default) or Plain text.

Add, save, and delete attachments
To open an attachment in a mail message, select the message
and then the attachment.
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Add an attachment to a mail message
Open the menu, and select Add attachment.

Save an attachment
Select the attachment and Save attachments. Enter a name
for the attachment, and select Save.

Delete an attachment
Open the menu, and select Remove attachments.

Create a mail signature
1 Select  > E-mail.
2 Select Edit account and the desired account.
3 Select Signature.
4 Select the Use signature check box.
5 Enter your signature, and select Save.

The signature is added to the end of the body text of all
messages you send using this account. You can edit and
delete the signature before you send the mail message.

Tips for creating mail messages

Insert an image to the body of a mail message
Select Insert image.

Copy text from a mail message
1 Tap the message at the point where you want to start

copying.

2 Press and hold the shift key, and tap the point where you
want to stop copying.

3 Press ctrl + C to copy the text, and ctrl + V to paste it to
another location.

Organise your mail
Organise mail messages and attachments
Select  > E-mail.

To sort messages in mail folders, select the folder, then
Sort and the desired sorting method and order.

Search within a mail message
1 Select  > E-mail.
2 Open a mail message.
3 Open the menu, and select Find in message. The search

bar is displayed.
4 Enter the search terms to the search bar, and select enter.

Matching terms are highlighted.

Delete mail messages
To delete a mail message, select the message and .

For POP3 accounts, if you have activated the Leave messages
on server option in the incoming mail settings, the message
is only deleted from your device. If you deactivate the option
and want to delete the message from the server, select the
message and Delete.

For IMAP4 accounts, the messages you delete are always
deleted from the server.
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Synchronise with Mail for Exchange
Synchronisation takes place automatically in intervals that
you have defined when setting up the Mail for Exchange
account. You can also start the synchronisation manually at
any time.

Only the content that you have defined when setting up the
account is synchronised. If you want to synchronise more
content, modify the Mail for Exchange settings.

Start the synchronisation manually
Select Synchronise manually.

Related topics
• See "Mail for Exchange settings", p. 60.

Modify mail settings
Mail account settings
Select  > E-mail.

Open the E-mail menu, and select Edit account and an
account. Ensure that you are not connected to the mailbox.

For the correct settings, contact your mail service provider.

Account details
Select Account details and from the following:
Account title  — Enter a title for the account.
Leave messages on server  — For POP3 accounts only. Set
the device to leave a copy of retrieved messages on the
server.

User details
Select User details and from the following:
Name  — Enter a name that is displayed as the sender in
messages.
User name and Password — Enter your user name and
password for the mail service.
E-mail address  — Enter your mail address.
Signature  — Edit your signature.

Settings for incoming mail
Select Incoming details and from the following:
Incoming server  — Enter the host name or IP address of the
POP3 or IMAP4 server that receives your mail.
Secure connection  — Define the security setting for
incoming messages. Follow the instructions from your mail
service provider.
Port  — Enter the port number. Follow the instructions from
your mail service provider.
Secure authentication  — Set the system to use secure
authentication.

Settings for outgoing mail
Select Outgoing details and from the following:
Outgoing server  — Enter the host name or IP address of the
SMTP server that sends your mail.
Secure authentication  — Set the system to use secure
authentication.
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User name and Password — Enter your user name and
password for the SMTP server.
Secure connection  — Define the security setting for
outgoing messages.
Port  — Enter the port number. Follow the instructions from
your mail service provider.
Use connection-specific SMTP servers  — Use connection-
specific SMTP servers for sending mail messages. To edit SMTP
server settings, select Edit SMTP servers.

Mail settings
1 Select  > E-mail.
2 Open the E-mail menu, and select Settings.
3 Select an account, and define the following:

Default account  — Define which account is the default
account. The first account created is set as default.
New message format  — Select the format of new mail
messages. The default value is Formatted text (HTML).
Update automatically  — Set the device to retrieve
messages automatically.
Update when connected via  — Define which
connection type is used to retrieve mail automatically.
Update interval  — Define how often messages are
retrieved. The default value is 15 minutes.

Nokia Messaging settings
Select  > E-mail and Edit account > Nokia
Messaging.

View user details

Select Service info. You cannot edit these fields.

Modify Nokia Messaging settings
Select Synchronisation. Define the following:
Days  — Select the days on which you want the
synchronisation to be done.
Hours  — Select the time during which you want the
synchronisation to be done on the selected days.
Sync while roaming  — Select this option if you want
synchronisation to be done when you are roaming outside
your home network.
Disable sync when  — Define a level of battery power at
which you want synchronisation to stop.
Send and receive  — Define the synchronisation interval.
Sync inbox  — Select this option if you want your inbox to
be synchronised.
Download size  — Select if you want to download only the
mail message header, partial message or full message.
Remove items older than  — Select a time period after
which mail messages are deleted from the device.
Sync drafts  — Select this option if you want the mail
messages in your drafts folder to be synchronised.
Sync sent items  — Select this option if you want the mail
messages in your sent items folder to be synchronised.
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Add or modify mailboxes
1 Select Nokia Messaging: Mailboxes.
2 To add a new mailbox, select Add new mailbox. The title

of each mailbox is retrieved from the Nokia Messaging
server. Select a mailbox.

3 To modify a mailbox, select the mailbox. Edit the
information as necessary.

Mailbox name  — Modify the mailbox name.
Sync read to server  — Select this option if you want the
read status of your mails to be synchronised to the server.
My name  — Modify your name.
Password  — Modify your password.
E-mail address  — Your mail address. You cannot modify
this field.
Use signature  — To use a signature, select the check
box, and Signature. Enter the signature, and select
Done.

Mail for Exchange settings
Select  > E-mail. Open the menu, and select Edit
account > Mail for Exchange.

View synchronisation details
Select Details. The number of items that were added,
updated, or deleted in the last synchronisation are displayed.

To modify Mail for Exchange settings, select Settings and
from the following:

Synchronisation schedule
Peak start time and Peak end time — Select a start and end
time for the peak period.
Peak days  — Select the days of the week when you want
the peak times to apply. You must select at least one day.
Peak schedule  — Select a synchronisation interval for peak
periods. If you select Always on, new received messages and
other changes on the server are pushed into the device
without delay.
Off-peak schedule  — Select a synchronisation interval for
off-peak periods.

Connection
Server — Edit the address of the Exchange server.
Port — Edit the port number for the Exchange server
connection.
Secure connection  — Use a secure connection.
Conflict resolution  — Define which item is kept if it has been
edited on both the device and server since the last
synchronisation.

Credentials
User name — Edit your Exchange server user name.
Password — Edit your Exchange server password.
Domain — Edit your domain on the Exchange server.

E-mail
Synchronise e-mail  — Enable mail synchronisation.
E-mail address — Edit your mail address.
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Account title — Edit the account title.
Signature  — Use a signature in the mail messages sent from
your Mail for Exchange account.
Synchronise messages back  — Define how old messages
are synchronised from the server.
When sending e-mail  — Define if outgoing messages are
sent immediately or only at the next synchronisation.
Copy outgoing e-mails  — Copy sent mail to the Sent folder
on the server side.

Calendar and tasks
Synchronise calendar and tasks  — Enable calendar and
task synchronisation.
Calendar  — Define which calendar is used for Mail for
Exchange.
Synchronise calendar back  — Define how old calendar
events and tasks are synchronised with the server.
Synchronise completed tasks  — Include completed tasks
in the synchronisation.

Contacts
Synchronise contacts  — Enable contact synchronisation.
First synchronisation  — Define whether all local contacts
are removed when the device synchronises with the server
for the first time.

Resynchronisation
Full resynchronisation  — Start full resynchronisation.

The available options may vary.

Related topics
• See "Set up a Mail for Exchange account", p. 54.

Configure connection specific SMTP servers
Configuring connection specific SMTP servers enables the
mail application to connect to an SMTP server and send mails
when you are roaming between connections of different mail
service providers.

1 If you want to use connection specific SMTP servers,
 > E-mail, open the menu, and select Edit

account.
2 Select the desired account.
3 Select Use connection-specific SMTP servers.
4 To edit SMTP servers, select Edit SMTP servers. Make the

changes, and select Save.

Capture images and record video clips

Your device supports an image capture resolution of
2576x1921 pixels (5 megapixels). The image resolution in
this guide may appear different.

Camera
Activate the camera

Open the lens cover. If the camera is active in the background,
and the lens cover is open, press the capture key to activate
the camera.
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Capture images
Image indicators
The indicators in the camera viewfinder area display the
current camera settings. The indicators in image mode are
the following:

1 Close
2 Scene mode in use (for example, Automatic)
3 Capture settings (  )
4 Flash mode in use (for example, Automatic)
5 Photos (  )
6 Zoom level (hidden at the default zoom level)
7 Autofocus crosshair ( , not shown in all image modes)
8 Image counter (estimated number of images you can

capture using the current settings and available memory)
9 Memory in use (for example, Internal storage)
10 Image resolution (for example, )
11 White balance (for example,  ). Only visible if set to

other than Automatic.

12 Exposure (for example,  ). Only visible if set to other
than 0.

13 ISO sensitivity (for example,  ). Only visible if set to other
than Automatic.

14 Geotag ( , if geotagging is enabled). The icon blinks
when the coordinates for the location are being
retrieved.

Related topics
• See "Scene modes", p. 65.
• See "Image settings", p. 66.
• See "Flash settings", p. 66.
• See "General settings", p. 67.

Capture images
When capturing an image, note the following:

• Use both hands to keep the camera still.
• The quality of a digitally zoomed image is lower than that

of a non-zoomed image.
• The camera goes into battery saving mode if you perform

no actions for about a minute. To continue capturing
images, activate the touch screen.

Keep a safe distance when using the flash. Do not use the
flash on people or animals at close range. Do not cover the
flash while taking a picture.

Capture an image
1 To activate the camera, open the lens cover.
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2 To switch from video mode to image mode, select .
3 To lock the focus on an object, press the capture key

halfway down. A green locked focus indicator is
displayed. If the focus was not locked, a red focus
indicator is displayed. Release the capture key, and press
it halfway down again. You can also capture an image
without locking the focus.

4 To capture an image, press the capture key all the way
down. Do not move the device before the image is saved.

Zoom in or out
Use the volume keys.

Switch between normal and full screen mode
Tap the viewfinder area.

Related topics
• See "Touch screen actions", p. 18.

Geotag images and video clips
If you have enabled geotagging, the device saves geotag
information such as country, city, and suburb, of every image
and video clip you capture or record.

You need an internet connection to be able to add geotag
information to your files.

It may take several minutes to obtain the geotag information.
The availability and quality of GPS signals may be affected by
your location, buildings, natural obstacles, and weather
conditions. Your geotag information is not saved anywhere

else than your device. If you share a file that includes geotag
information, also the geotag information is shared, and your
location may be visible to third parties viewing the file.

Enable geotagging
When you activate the camera for the first time, the device
asks you whether you want to enable geotagging. To enable
geotagging later, do the following:

1 Select  > Camera.
2 Open the Camera menu, and select Geotagging.
3 Select the Enable geotagging check box and Done.

Related topics
• "View images with Photos "

After capturing an image
After you have captured an image, the post-capture view is
displayed. In this view, you can, for example, delete the
image or edit the tags of the image.

If you have set Show captured image to No in the general
camera settings, the camera returns to the pre-capture view,
and the post-capture view is not displayed. In this case, you
can edit the image in Photos.

In the post-capture view, if the image you captured is
successfully geotagged, the country, city, and suburb geotags
are displayed. If the geotags are not readily available at the
moment of capture, the device tries to retrieve the geotags.
Acquiring geotags is displayed.
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After capturing an image, select from the following:

  — Return to the pre-capture view.
  — Edit image tags and geotags.
  — Share your image with others.
  — Delete the image.
  — Open the Photos application.

You cannot zoom images in the post-capture view.

Related topics
• See "Modify images", p. 68.
• See "View images", p. 67.
• See "Share your images and video clips ", p. 69.
• See "General settings", p. 67.

Record video clips
Video indicators
The indicators in the camera viewfinder area display the
current camera settings. The indicators in video mode are the
following:

1 Close
2 Scene mode in use (for example, Automatic video)
3 Capture settings (  )
4 Media player (  )
5 Zoom level (hidden at the default zoom level)
6 Autofocus crosshair (  )
7 Time remaining. Estimated total video recording time,

using the current settings and available memory.
8 Memory in use (for example,  )
9 White balance (for example,  ). Only visible if set to

other than Automatic.
10 Exposure (for example,  ). Only visible if set to other

than 0.
11 Geotag ( , visible if geotagging is enabled). The icon

blinks when the coordinates for the location are being
retrieved.

Related topics
• See "Scene modes", p. 65.
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• See "General settings", p. 67.
• See "Video settings", p. 66.

Record video clips
Start recording
1 To activate the camera, open the lens cover.
2 To switch from image mode to video mode, if necessary,

select .
3 To lock the focus on an object, press the capture key

halfway down. A green locked focus indicator is
displayed. If the focus was not locked, a red focus
indicator is displayed. Release the capture key, and press
it halfway down again. You can also record a video clip
without locking the focus.

4 To start recording, press the capture key all the way
down.

The elapsed recording time is displayed in red.

Stop recording
Press the capture key.

Switch between normal and full screen mode
Tap the viewfinder area.

After recording a video clip
After you have recorded a video clip, the post-recording view
is displayed. In this view, you can, for example, delete the
video clip or edit tags.

If you have selected Show captured video > No in the
general camera settings, the camera returns to the pre-
recording view, and the post-recording view is not displayed.

In the post-recording view, select from the following:

  — Return to the pre-recording view.
  — Edit video clip tags and geotags.
  — Share your video clip with others.
  — Delete the video clip.
  — Open Media player, and play the video clip.

Related topics
• See "Play music and video clips", p. 72.
• See "Share your images and video clips ", p. 69.
• See "General settings", p. 67.

Change camera settings
Scene modes
When you activate the camera, the last used scene mode is
in use.

Select  > Camera and .

Select from the following:
 Automatic  — The default image scene mode. Capture

images in a variety of situations.
 Automatic video  — The default video scene mode.

Record video clips in a variety of situations.
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 Macro  — Focus on close up objects. The images may be
susceptible to noticeable camera shake.

 Landscape  — Capture landscape images with clear
outlines, colours, and contrast.

 Action  — Capture fast moving objects, using a short
exposure time. You can capture successive images rapidly.
The auto-focus crosshair is not displayed.

 Portrait  — Capture portraits of people, in good lighting
conditions.

Image settings
If you change the scene mode, the white balance, exposure,
and ISO sensitivity settings are reset to defaults. The image
resolution remains the same.

1 Select  > Camera and .
2 Select from the following:

White balance  — Select the current lighting conditions.
Colours are reproduced more accurately.
Exposure  — Adjust the exposure compensation. If you
are capturing a dark subject against a very light
background, such as snow, adjust the exposure to +1 or
to +2 to compensate for the brightness of the
background. For light subjects against a dark
background, use -1 or -2.
ISO sensitivity  — Adjust the light sensitivity. Increase
the light sensitivity in low light conditions, to avoid
underexposed and out of focus images. Increasing the
light sensitivity may also increase the image noise.

Resolution  — Select the image resolution.

Video settings
1 Select  > Camera.
2 Select  to switch from image mode to video mode, if

necessary.
3 Select  and from the following:

White balance  — Select the current lighting conditions.
Colours are reproduced more accurately.
Exposure  — Adjust the exposure compensation. If you
are filming a dark subject against a very light
background, such as snow, adjust the exposure to +1 or
to +2 to compensate for the brightness of the
background. For light subjects against a dark
background, use -1 or -2.

Flash settings
Keep a safe distance when using the flash. Do not use the
flash on people or animals at close range. Do not cover the
flash while taking a picture.

If you change the scene mode, the flash settings are reset to
defaults.

1 Select  > Camera and .
2 Select from the following:

 Automatic  — The flash is used automatically, if the
lighting conditions require it.
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 Always on  — The flash is always used. Captured
images may be overexposed.

 Red eye reduction  — A pre-flash is used, to reduce
the red eye effect.

 Always off  — The flash is not used. Captured images
may be underexposed and out of focus.

General settings
1 Select  > Camera and .
2 Select from the following:

Memory in use  — Select Internal storage or a memory
card, if inserted. Files are stored in the Camera folder. If
the folder does not exist, the camera creates it.
Creator name  — Enter a name that is automatically
inserted into the metadata of your captured images or
recorded video clips.
Show captured image  — Define how long images are
displayed after being captured. If you do not want the
image to be displayed at all, select No. This setting is
available if the image mode is in use.
Show captured video  — Define how long video clips
are displayed after being recorded. If you do not want
the video to be displayed at all, select No. This setting is
available if the video mode is in use.

View images with Photos
View images
With Photos, you can view images as thumbnails in a grid, or
full images individually. You can zoom, pan, and edit images

and image tags. You can also view slide shows, use a TV-out
cable to view images on a TV, and share images with your
friends.

View images in a grid
Select and hold the image to share, delete, mark or unmark
as favourite, or view image details.
In the grid view, you can view and browse through multiple
images inside one folder or filter set. The images are
displayed as thumbnails. Small icons on the thumbnails
indicate metadata, such as tags.

View an image in full screen mode
Select the image from the grid.

View images as a slide show
In full screen mode, select . To stop the slide show, select
anywhere on the display.
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To view images on a TV screen, connect a compatible TV-out
cable to your device.

Related topics
• See "Edit tags", p. 69.
• See "Sort images", p. 68.
• See "Modify Photos settings", p. 69.
• See "Share your images and video clips ", p. 69.

TV-out settings 
1 Select  > Settings and TV out.
2 Select PAL (default, used in Europe, for example) or

NTSC (used in North America, for example).
3 Select Save.

Sort images
Select  > Photos, and open the menu.

Sort images by date
Select Filter by date, and select whether to view images from
a certain day or period of time.

Sort images by tags
Select Filter by tags, and select terms that should be in the
metadata of the images you want to view.

Sort images by folders
1 Select Filter by folder.
2 Select from the following:

Camera default folder  — View the folder where the
Camera application saves captured images.
Custom folder  — Select the folder you want to view.
All images  — View all images that are found in the
device or on a memory card, if available.

Modify images
Select  > Photos.

Open an image for editing
1 Select the image you want to modify from the grid. The

image is displayed in full screen mode.
2 Tap the image.

Rotate an image
Select .

Crop an image
Select .
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Delete an image
Select .

Share an image
Select .

Undo or redo an action
Select  or .

Use other editing options
Open the menu, and select Edit image. You can, for example,
resize and image, flip an image horizontally or vertically, or
adjust the brightness and contrast settings.

Edit tags
You can create new tags, edit previously created tags, add or
edit location information, or remove tags from images.

Select  > Photos.

1 Select the image that you want to edit.
2 In normal screen mode, select .

You can also edit multiple images' tags in grid view
mode. Open the menu, and select Edit images' tags and
the images that you want to edit.

3 Select the desired tags from the cloud and Done.

Edit location information
Select Geotags. Geotag items must be selected individually.

Create a new tag
Select New, enter a tag name, and select Done.

Modify Photos settings
1 Select  > Photos.
2 Open the menu, and select Settings.
3 Define the following:

Sort  — By default, the thumbnails are in chronological
order, starting with the oldest image. You can also sort
images by name.
Slideshow  — Define the pace of slide shows.

Group images by month
To view images separated with month titles in the grid view,
select Group by month.

Display metadata indicators
To see small metadata icons on the images that have
metadata attached to them, select Display metadata
indicators.

The options available for editing may vary.

Share your images and video clips

About sharing content
You can share your content, for example, images or video
clips, by uploading them to internet services, such as Nokia
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Ovi services or Flickr. To share, you must have a working
internet connection and an existing sharing account.

Create a sharing account
To be able to send your content to different services, you need
a sharing account. If you do not have an account, when trying
to share, the device prompts you to create an account first.
Follow the instructions on the display.

To create a new sharing account in advance, do the following:

1 Select  > Settings and Sharing accounts > New.
2 Select the service.
3 Enter the user name and password, and select Validate.

Depending on the service, you may have to set up an
account using a web browser. Follow the instructions on
the display.

Related topics
• See "Edit sharing account ", p. 71.

Share items
1 Select the items you want to share and Share via

service.
2 Enter a title and description, and select Share.

You can edit the tags, select which sharing account to
use, or modify the sharing options.
When sharing multiple items, to edit the metadata of an
individual image, tap the thumbnail of the image.

The changes you make to files when sharing will not
affect the metadata of the actual content.

Related topics
• See "Modify sharing settings", p. 71.

Tags
When sharing content, you can see possible metadata
indicators as small icons on the images' thumbnails.

  — Title, description or tags are assigned to the image.
  — The file contains GPS coordinates or information of the

file creator. If the metadata is not yet selected to be removed,
 is displayed.

Edit tags
Select Tags.

Related topics
• See "Edit tags", p. 69.

Share items using Bluetooth connectivity
1 Select the items you want to send and Send via

Bluetooth.
2 Select the device to which you want to send the items.

You may need to pair with the device first.

Related topics
• See "Send data using Bluetooth connectivity", p. 34.

70 Share your images and video clips



Send items using mail
Select the items you want to send, and select Send via E-
mail.

Related topics
• See "After capturing an image", p. 63.

Modify sharing settings
1 When sharing content, select Options and from the

following:

Image size  — Define the image size.
Metadata  — Define which content details are sent with
the content.
Privacy  — Define who can see the content in your Flickr
account.
Album  — Select the Ovi album for the content.

2 Select Done.

The settings available for editing may vary.

View sharing status
After selecting Share, the content is moved to the upload
queue. In the status area, the status of the current upload is
indicated with the following icons:

Sharing is ongoing.
Sharing is pending because there is no connection
available. Open the status area menu and select the
icon to try establishing a connection, or cancel the
sharing.

Sharing is blocked because an error has occurred.
Open the status area menu and select the icon to see
more detailed information of the error, and retry or
cancel the sharing.

When the upload is complete, the icon is removed from the
status area.

Edit sharing account
Select  > Settings and Sharing accounts. Select an
account and Edit.

Ovi account

Change the password
Enter the new password, and select Save.

Remove the account
Select Delete.

If you are editing the account details using your device, you
cannot change your user name.

Flickr account

Edit account details
Select Edit. Follow the instructions. Return to the account
editing dialog, and select Validate.

Remove the account
Select Delete.

Share your images and video clips 71



Flickr account details can only be edited using the browser.

Play music and video clips

About Media player
With Media player, you can listen to music and other audio
files stored in your device or on a compatible memory card
(if inserted) and audio streams from the internet. You can also
play video clips or streamed video clips from the internet, and
stream content from available media servers.

Select  > Media player.

Listen to music
Select .

Play video clips
Select .

Listen to internet radio
Select .

Shuffle between all songs
Select .

Related topics
• See "Play music with Media player ", p. 73.
• See "Use the FM transmitter ", p. 75.
• See "Play video clips with Media player ", p. 75.
• See "Listen to internet radio with Media player

", p. 76.

File formats
Select  > Media player.

The supported video file formats are: 3GP, MOV, AVI, MP4,
WMV, and ASF. Streaming performance depends on the
bandwidth availability.

The supported audio file formats are: MP3, AAC, WMA, M4A,
AMR, AWB, and WAV.

The Media player application supports M3U, PLS, ASX, WAX,
WVX, and WPL playlists.

Media player does not necessarily support all features of a file
format or all the variations of file formats.
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Add the media widget to desktop
You can add the media widget to the device desktop. With
the widget, you can control audio playback (music or internet
radio), and display the media player's Now playing view.

Tap the desktop, and select  > Desktop menu > Add
widget > Media player.

Search for media files
1 Select  > Media player.
2 In views that list media files, start entering search terms

using the keyboard. The search bar becomes visible.
Matching files are displayed.

Play music with Media player
Play music
Select  > Media player and Music.

Play a song
Select .

Pause playback
Select .

Stop playback
Select .

Play the next or previous song
Select  or .

Repeat the currently playing song
Select .

Fast-forward or rewind
Select and hold  or .

Shuffle
Select .

Adjust the volume
To open and close the volume controls, select . Use the
slider or volume keys to adjust the volume.

Browse the music library
Select  > Media player and Music.

Music library view

Browse the music library
Select All albums, All songs, Genres, Artists, or Playlists.

Now playing view

Access the Now playing view
Select .

Switch between the Now playing and current song views
Select the album art image.
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In the Now playing view, you can access the FM transmitter,
save the playlist, or clear the current playlist from the menu.

If you close and reopen the Media player application, the last
selected view is used.

View playlists
The Media player library contains a default set of automatic
playlists. The contents of the playlists are updated each time
they are opened. You cannot edit or delete automatic
playlists.

1 Select  > Media player and Music.
2 Open the menu, and select Playlists and from the

following:

Recently added  — View recently added songs.
Recently played  — View recently played songs.
Most played  — View the most played songs.
Never played  — View the songs you have never played.

Add songs to current playlists
Select  > Media player and Music.

Add a song to the current playlist
Select a song and Add to current playlist.
The selected song is added to the Now playing view.

Add all songs in a library view to the current playlist
In a library view (Artists, Album, Songs), open the menu, and
select Add songs to current playlist.

All music items on current library view are added to Now
playing list.

Clear the Now playing list before adding new songs
In the Now playing view, open the menu, and select Clear
current playlist (possible only in Now playing view for
Music).
The playback is stopped and the previous view is shown.

Save playlists
1 Select  > Media player and .
2 To save the items in the Now playing view as a playlist,

select Save playlist.
3 Enter a name for the playlist, and select Save.

Shuffle songs
With the shuffle feature, you can listen to songs from the Now
playing view or playlists in a random order.

Select  > Media player.

Shuffle songs
Select .

Stop shuffling
Select .
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Use the FM transmitter
About the FM transmitter
With the FM transmitter, you can play songs in your device
using a compatible FM receiver, such as a car radio or a home
stereo system.

The availability of the FM transmitter may vary by country. At
the time of writing, the FM transmitter may be used in the
following European countries: Austria, Belgium, Bulgaria,
Czech Republic, Denmark, Estonia, Finland, Germany, Iceland,
Ireland, Lithuania, Liechtenstein, Luxembourg, Malta,
Netherlands, Norway, Portugal, Spain, Switzerland, Sweden,
Turkey, and United Kingdom. For the latest information, and
the list of non-European countries, see www.nokia.com/
fmtransmitter.

The operating distance of the FM transmitter is up to a
maximum of 3 metres (10 feet). The transmission may be
subject to interference due to obstructions, such as walls,
other electronic devices, or from public radio stations. The FM
transmitter may cause interference to nearby FM receivers
operating on the same frequency. To avoid interference,
always search for a free FM frequency on the receiver before
using the FM transmitter.

The operating frequency of the transmitter ranges from 88.1
to 107.9 MHz.

If the transmitter is not transmitting anything for one
minute, it switches off automatically.

The FM transmitter cannot be used while the headset or TV-
out cable is connected.

Play music using FM transmitter
Select  > Media player.

1 Select a song to play, open the menu, and select FM
transmitter.

2 To activate the FM transmitter, select FM transmitter
on.

3 To select the frequency, select Frequency.

Calls are not broadcast using the FM transmitter. Playback is
paused for the duration of the calls.

FM transmitter settings 
1 Select  > Settings and FM transmitter.
2 To activate the FM transmitter, select FM transmitter

on.
3 To select the frequency, select Frequency.

Play video clips with Media player
Play video clips
Select  > Media player and Video.

Play a video clip
Select .

Fast-forward or rewind
Select and hold  or .
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Adjust the volume
To open and close the volume controls, select . Use the
slider or the volume keys to adjust the volume.

Delete a video clip
Select .

Browse the video library
The video library contains video clips recorded with the
device camera, transferred from your PC, or downloaded from
the web, and bookmarked video streams.

1 Select  > Media player and Video.
2 Open the menu, and filter the view by date or category.

Add video bookmarks
1 Select  > Media player.
2 Select Video > Video bookmarks > Add video

bookmark.
3 Enter the name and web address of the bookmark, and

select Save.

You can also search for video streams in the browser. When
the stream is playing, to save it as a bookmark, select Add
video bookmark > Save.

Use TV-out to play video clips on your TV
Set the used television system
1 Select  > Settings and TV out.

2 Select PAL (default, used in Europe, for example) or
NTSC (used in North America, for example).

3 Select Save.

Play video clips on a TV
1 Connect a compatible TV-out cable to your device.
2 Select Media player > Video and a video clip.

You can make and answer calls when connected to the TV.

Play video clips from the internet
1 Select  > Media player.
2 To play video clips streamed from the internet, select

Video and a bookmark, or, when browsing the internet,
select a video clip.

Listen to internet radio with Media player
Listen to internet radio
With Internet radio, you can listen to internet radio stations
or other compatible audio streams. The Internet radio
application supports MP3 and WMA files, and M3U, PLS, and
WPL playlists. Some playlist file formats, such as ASX and WAX,
are supported only partially.

Select  > Media player.

Listen to a radio station
Select Internet radio and the desired station from the list.

Pause playback
Select .
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Stop listening
Select .

Listen to the next or previous radio station
Select  or .

Adjust the volume
To open and close the volume controls, select . Use the
slider or the volume keys to adjust the volume.

Add internet radio stations
Internet radio can include one or more web links to radio
streams.

1 Select  > Media player and Internet radio.
2 Open the menu, select Add radio bookmark, and enter

the web address of the station. If you are already
listening to a station, the details are automatically
provided.

3 To save the station, select Save. The radio station is
added to the Internet radio stations view.

Browse media servers
Select  > Media player.

After scanning the wireless network, discovered media
servers are displayed at the bottom of the main Media player
view.

When you select a server, the root directory of the server is
loaded and displayed. You can browse the servers and their
content.

Find and view locations

Positioning (GPS)
About GPS
The coordinates in the GPS are expressed using the
international WGS-84 coordinate system. The availability of
the coordinates may vary by region.

The Global Positioning System (GPS) is operated by the
government of the United States, which is solely responsible
for its accuracy and maintenance. The accuracy of location
data can be affected by adjustments to GPS satellites made
by the United States government and is subject to change
with the United States Department of Defense civil GPS policy
and the Federal Radionavigation Plan. Accuracy can also be
affected by poor satellite geometry. Availability and quality
of GPS signals may be affected by your location, buildings,
natural obstacles, and weather conditions. GPS signals may
not be available inside buildings or underground and may be
impaired by materials such as concrete and metal.

GPS should not be used for precise location measurement,
and you should never rely solely on location data from the
GPS receiver and cellular radio networks for positioning or
navigation.

The trip meter has limited accuracy, and rounding errors may
occur. Accuracy can also be affected by availability and quality
of GPS signals.
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Different positioning methods can be enabled or disabled in
positioning settings.

Assisted GPS (A-GPS)
Your device also supports assisted GPS (A-GPS).

A-GPS requires network support.

Assisted GPS (A-GPS) is used to retrieve assistance data over
a packet data connection, which assists in calculating the
coordinates of your current location when your device is
receiving signals from satellites.

When you activate A-GPS, your device receives useful satellite
information from an assistance data server over the cellular
network. With the help of assisted data, your device can
obtain the GPS position more quickly.

Your device is preconfigured to use the Nokia A-GPS service,
if no service provider-specific A-GPS settings are available.
The assistance data is retrieved from the Nokia A-GPS service
server only when needed.

You must have an internet access point defined in the device
to retrieve assistance data from the Nokia A-GPS service over
a packet data connection. You can define the access point for
A-GPS in network positioning settings. A wireless LAN (WLAN)
access point cannot be used for this service. Only a packet
data internet access point can be used. Your device asks you
to select the internet access point when GPS is used for the
first time.

Related topics
• See "Location settings ", p. 79.

Hold your device correctly
When using the GPS receiver, ensure you do not cover the
antenna with your hand.

Establishing a GPS connection may take from a couple of
seconds to several minutes. Establishing a GPS connection in
a vehicle may take longer.

The GPS receiver draws its power from the device battery.
Using the GPS receiver may drain the battery faster.

Position requests
You may receive a request from a network service to receive
your position information. Service providers may offer
information on local topics, such as weather or traffic
conditions, based on the location of your device.

When you receive a position request, the service that is
making the request is displayed. To allow your position
information to be sent, select Accept. To deny the request,
select Reject.
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Location settings 
Select  > Settings and Location.

GPS settings
Select from the following:
Enable  — Activate the internal GPS receiver in your device.
The GPS receiver is automatically activated when an
application that uses GPS data is opened.
GPS device  — Select the GPS receiver to use.
Pair new device  — Pair an external GPS receiver with your
device. Select the GPS receiver from the list of found devices.

Network positioning settings
Select from the following:
Enable  — Activate the network-based positioning service
(including A-GPS).
Location server  — Enter the location server address.

Ovi Maps for mobile
About Maps
With Maps, you can see your current location on the map,
browse maps of different cities and countries, search for
places, and plan routes from one location to another.

When you open Maps, you may need to select an internet
access point for streaming maps.

When you browse to a new area on the map, the map is
streamed through the internet. Some maps may be available
in your device or on a memory card.

Tip: To avoid data transfer costs, you can also use Maps
without an internet connection, and browse the maps that
are saved in your device or memory card.

Note:  Downloading content such as maps, satellite images,
voice files, guides or traffic information may involve
transmission of large amounts of data (network service).

Almost all digital cartography is inaccurate and incomplete
to some extent. Never rely solely on the cartography that you
download for use in this device.

Related topics
• See "Search for a place", p. 80.
• See "Plan routes", p. 80.
• See "Maps settings", p. 80.

Move on a map

View the map
Select your location from the main view.

Move on the map
Drag the map.

Zoom the map
Select + or -, or select  and the country, state, city, or street
view.

Rotate the map
Select , and drag the  icon.
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Change the map type
Select  and the desired option.

Create a route to a location
Select the location information box and Route. Maps creates
a route from your current position, if available.

Search for a place
1 Select Find Places.
2 Enter the search term in the search field.
3 Select from the list of suggested matches.

View the place on the map
Select the place.

Plan routes
You can create routes and view them on the map.

Create a route
1 Select Route planner. Maps automatically sets your

current location as the starting point, if available. To
change the starting point, select Press here to set
starting point manually., and search for the starting
point or select it from the map.

2 Select Add destination, and search for the next place on
your route, or select it from the map.

3 To add more places to the route, select Add stopover.

View the route directions
Select  and Directions.

Change the route properties
Select  and Route Settings.

Maps settings

Modify the settings
In the main view, select Maps.

Synchronise and transfer content from another
device

Synchronise content
Synchronise with a compatible device for the first time
If you want to synchronise using Nokia PC Suite, you need to
start the synchronisation from the PC. Otherwise, do the
following:

1 Select  > Settings and Transfer & sync > Next >
Synchronise data.

2 Select the device with which you want to synchronise
data. You may need to pair with the device.

3 Select which content you want to include in the
synchronisation. If you synchronise calendar entries,
select which calendar you want to use.

4 Select Finish to start the synchronisation.
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The length of time needed to complete the synchronisation
depends on the amount of data to be transferred.

Synchronise again
Select the desired synchronisation settings from the list, and
select Sync.

Handle synchronisation conflicts
If an item to be synchronised has been edited in both devices,
the device attempts to merge the changes automatically. If
this is not possible, there is a synchronisation conflict. Select
the version you want to save.

Related topics
• See "Manage transfer details", p. 81.

Transfer data
Transfer data for the first time
1 Select  > Settings and Transfer & sync > Next.
2 Select Retrieve data or Send data.
3 Select the device with which you want to transfer data.

You may need to pair with the device.
4 Select which content you want to include in the data

transfer.
5 Select Finish to start the data transfer.

Transfer content again
After a data transfer, the transfer details are saved in the
Transfer & sync main view. You can later transfer data using
the same settings.

To transfer content again, select the desired data transfer
details from the list, and start the transfer.

Related topics
• See "Manage transfer details", p. 81.

Manage transfer details
In the Transfer & sync main view, you can see the details of
previous data transfers. You can modify, delete, or create new
transfer settings.

Modify transfer details
1 Select the transfer details from the list.
2 Select Content.
3 Select which contents you want to include in the data

transfer, and select Done.

Create new transfer details
Select New. A data transfer wizard opens, and you can start
a new data transfer. The details are then stored in the main
view list.

Delete transfer details
Select the transfer details from the list, and select Delete to
clear the transfer details.
Deleting transfer details will not delete the content from the
device.
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Back up and restore data

About backups
You can back up data to the device mass memory or a
compatible memory card, and if necessary, restore the data
to the device. The backup appears as a folder on the device
mass memory or memory card. You can also secure the
backup with a password.

You can back up the following:

Communication and Calendar — Mail and chat messages and
accounts, text messages, contacts in the Contacts application,
calendar events, clock alarms, and alarm settings
Bookmarks  — Bookmarks from web browsers
Settings  — All application configurations
Application list  — A list of the applications installed in your
device

Create a new backup
1 Select  > More... > Backup and New backup.
2 Enter a descriptive name, define the desired location of

the backup, and select Proceed.
3 Select the data types you want to back up.
4 If you want to protect the backup with a password, select

the Protect with password check box, enter the
password twice, and select Done.

Restore a backup
1 Select  > More... > Backup.

2 Select the desired backup and Restore.
3 Select the data types to restore.
4 Confirm that you want to restore the data.

If the backup is password-protected, enter the password,
and select OK.

5 If your device contains a newer version of the files than
the backup you are restoring, the device asks you to
confirm if you want to save the backed up version, or
cancel data restore. Select from the following:

Yes  — The device overwrites the current version with
the backed up file.
Yes to all  — The device overwrites all conflicting files
without further confirmation.
No  — The version on the device is not replaced.

Update software and install applications

About Application manager
Select  > More... > App manager.

Application manager allows you to install new applications
and other extensions from application catalogues
(repositories). You can also list, update, and uninstall
packages.

Important:  Only install and use applications and other
software from sources that you trust. Applications from
untrusted sources may include malicious software that can
access data stored in your device, cause financial harm, or
damage your device.
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About application packages and catalogues
Application manager works with packages that are generally
contained in application catalogues, that you can access over
a network connection.

An application package is a set of files. It can contain an
application that you open from the Applications folder, a
plug-in for the desktop, a new theme, or other kinds of add-
ons.

A catalogue is a set of packages. It can include different kinds
of software combined as application packages. Certain
packages can be shared by many applications. For the
software to install successfully, the whole catalogue is
needed. A list of available packages is saved in the device.

On some websites, you can install an application directly by
selecting a link to a file with the .install file extension. The
Application manager opens, and installs the application. If a
new catalogue is needed for the application, the Application
manager also offers to add it automatically.

View log
You can use the log to view event details and to diagnose
unusual behaviour in the Application manager. The content
of the log is deleted when you close the application.

Open the Application manager menu, and select Log.

Save the log
Select Save as, enter a name for the log, and define where
you want to save it. The log is saved as a text file.

Install additional applications
Browse and search installable applications
Select  > More... > App manager and Download.

Browse applications
Select a category to browse a list of installable application
packages. If there are only a few packages available, the
category list is not displayed.
The package list contains the name, version, and size of each
package. When you select a package, a short description of
its contents is displayed, and you can install, search, or view
details of the package.

Search for applications
Open the menu, select Search, enter search words, and select
the search area and Search.

View application details
Select the application and Details.

Show installed applications
Select  > More... > App manager and Uninstall.

The applications can be searched and sorted, and their details
viewed, in the same way as when browsing installable
applications.

Related topics
• See "Browse and search installable applications", p. 83.
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Uninstall applications
1 Select  > More... > App manager and 

Uninstall.
2 Select an application and Uninstall.

Once confirmed and started, the uninstallation process
cannot be cancelled.

Add catalogues
View, install, and edit catalogues
You can view, install, edit, and delete catalogues. It may not
be possible to edit or delete preinstalled catalogues.

Select  > More... > App manager.

View available catalogues

Open the Application manager menu, and select
Application catalogues. The list of catalogues is displayed.
If refreshing a catalogue fails, select the catalogue name to
view the details.

Install catalogues
You can only install a catalogue's packages if the catalogue is
installed on your device. If you select an .install file, for
example, from a website, and the catalogue needed to fulfil
all dependencies is not installed on your device, you are
prompted to install the catalogue. If you cancel the
installation, you will not be able to install any of the
packages.

1 Open the Application manager menu, and select
Application catalogues > New.

2 Define the catalogue name.
3 Define the web address, distribution, and components

details, provided by the catalogue owner.
4 Select the Disabled check box to enable or disable a

catalogue. If you disable a catalogue, the device does not
search for updates or software packages from it.

5 Select Save.

Edit a catalogue
You can edit the information of each catalogue. You can also
disable a catalogue to hide its packages in the Application
manager.

Certain essential catalogues only allow you to enable or
disable the catalogue, you cannot edit any other information.

1 Open the Application manager menu, and select
Application catalogues and the catalogue.

2 Edit the details.
3 Select the Disabled check box to enable or disable a

catalogue.

Restore application packages
If needed, you can replace the existing application packages
with backup files you have previously created.

1 Select  > More... > App manager.
2 Open the Application manager menu, and select

Restore applications.
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3 Select the applications to restore and Yes.

The applications are retrieved from catalogues, using a
network connection.

Check for updates
To see a list of installed application packages that can be
updated, select  > More... > App manager and 
Update. The list contains the name, version, and size of each
package. When you select a package, a short description of
its contents is displayed.

You can select the packages you want to update or update all
available packages. You can also sort update packages in the
same way as when browsing installable applications, or view
application details.

To prevent any possible loss of data, back up your data before
installing operating system updates.

Related topics
• See "Browse and search installable applications", p. 83.

Update software
Software updates may include new features and enhanced
functions that were not available at the time of purchase of
your device. Updating the software may also improve the
device performance. You can update the software in your
device with Application manager or with Nokia Software
Updater.

Automatic software updates
When new software updates are available for the operating
system or for Nokia or third party applications, or when there
are additional applications available for your device,  is
displayed in the status area.

It is recommended that you install software updates as they
may contain important bug fixes and other updates. If you
dismiss the suggested updates, you can later install them
from the Application manager.

Downloading software updates may involve the transmission
of large amounts of data (network service).

Make sure that the device battery has enough power, or
connect the charger before starting the update.

Install software updates
1 Select the status area and New updates.
2 Open the menu, and select Update all, or select the

packages to install and Continue.
3 Confirm the installation.

Install additional applications
1 Select the status area and New releases.
2 To open a web page with details of an additional

application, select Download.

Check the version number of the software on your device
Select  > Settings and About product.
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Most software updates can be installed with the Application
manager. However, an update using Nokia Software Updater
may sometimes be necessary. In this case, you receive a
notification that a software update is available via Nokia
Software Updater.

Related topics
• See "Software updates using your PC", p. 86.

Software updates using your PC
Nokia Software Updater is a PC application that enables you
to update your device software. To update your device
software, you need a compatible PC, broadband internet
access, and a compatible USB data cable to connect your
device to the PC.

To get more information, to check the release notes for the
latest software versions, and to download the Nokia Software
Updater application, see www.nokia.com/softwareupdate or
your local Nokia website.

Update the device software with the Nokia Software
Updater
1 Download and install the Nokia Software Updater

application to your PC.
2 Connect your device to the PC using a USB data cable, and

open the Nokia Software Updater application. The Nokia
Software Updater application guides you to back up your
files, update the software, and restore your files.

Manage time

View time and set alarms
Select  > Clock.

You can view your local time and time zone information, set
and edit alarms, or modify date, time and regional settings.

Add and edit alarms
Add alarms
1 Select  > Clock and .
2 Enter the time for the alarm. You can create an alarm that

repeats on set days. You can also add a title.
3 Select Save.

Edit alarms
1 Select  > Clock and .
2 Select the alarm you want to edit.
3 Edit the title and time of the alarm, select the days on

which the alarm is to be repeated, and activate or
deactivate the alarm.

4 Select Save.

Turn off a sounding alarm
Select Stop.

Turn off the alarm for a certain period
Select Snooze.
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If your device is switched off when a clock alarm is due, your
device switches itself on and starts sounding the alarm tone.

Related topics
• See "Clock settings", p. 87.

View world clock
You can view the current time in different locations. The first
clock is the local time, and it opens the date and time settings.

Add a new world clock
1 Select  > Clock and .
2 Select New World clock.
3 Drag the map to the desired time zone, or select  to

search for a city.
4 Select Done.

Clock settings
Alarm settings
1 Select  > Clock, and open the menu.
2 Select Alarm settings.
3 Select the tone for the alarm clock and the time after

which the alarm sounds again when you set it to snooze.
4 Select Save.

Related topics
• See "Language and regional settings", p. 98.
• See "Date and time settings ", p. 97.

View and manage calendar
View the calendar
Select  > Calendar. Open the menu, and select Month,
Week, or Agenda.

With the calendar, you can do the following:

• Create events, tasks, and notes for different purposes
such as work, home, or hobbies. The items you enter in
different calendars appear in different colours.

• Create new calendars, and delete unnecessary calendars.
However, your device has two calendars that cannot be
deleted. The private calendar only exists in your device
and cannot be synchronised. The device main calendar is
used with the PC Suite, for example.

• Hide calendars without removing your events and tasks.
For example, you can hide your work calendar during
your holiday. When a calendar is hidden, its alarms are
off.

If you add birthdays to your contact cards, the birthdays are
collected into a birthday calendar. The alarm is off by default
for the birthdays, so you must edit them if you want to be
reminded.

View notes
Select Go to notes.

View all tasks
Select Go to tasks.
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Related topics
• See "Calendar settings", p. 89.

Add and edit calendars
Select  > Calendar, open the menu, and select
Settings > Edit calendars.

You can create different calendars for home, work, and
hobbies, for example.

Add a calendar
1 Select New, and follow the instructions of the Calendar

wizard.
2 Add the title and colour of the calendar, and select

whether the calendar is displayed.
3 Select Finish.

Edit a calendar
1 Select the calendar you want to edit.
2 Edit the title and colour of the calendar, and select

whether the calendar is displayed.
3 Select Save.

Add and edit calendar notes
Select  > Calendar, open the menu, and select Go to
notes.

Add a note
1 Select New note.

2 Write the note. To change the calendar, select
Calendar.

3 Select Save.

Edit a note
1 Select the note.
2 Edit the note. To change the calendar, select Calendar.
3 Select Save.

Add and edit tasks
Select  > Calendar, open the menu, and select Go to
tasks.

You can keep track of your schedule by creating task
reminders for yourself. After the task has been completed,
you can mark the task as done.

Add a task
1 Select New task.
2 Add the title and date, select which calendar to use, and

set the alarm.
3 Select Save.

Edit a task
Select the task, edit the details, and select Save.

Mark a task as done
Select Done.
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Add and edit events
You can reserve time in your calendar for events such as
appointments and meetings. You can also add reminders for
birthdays, anniversaries, and other events.

If you add a birthday to your contact cards, the birthdays are
automatically collected to a birthday calendar.

Select  > Calendar.

Add an event
1 Go to the desired date, and select New event.
2 Add the details of the event. You can set the event to

repeat regularly, set an alarm, and select which calendar
to use.

3 Select Save.

Tip: To add an event quickly, select Month, Week, or
Agenda, and start entering text using the physical keyboard.
The New event dialog opens, and you can edit the rest of the
information.

Edit or remove an event
1 Go to the date of the event.
2 Select the desired event, open the menu, and select Edit

event or Delete event.

Import events to calendar
You can import downloaded or local files with the .ics file
extension to your calendar.

1 Tap a file that has the .ics file extension.

2 Select a calendar from the list.
To import the content to a new calendar, select Create
new calendar.

3 Select Save.

Synchronise content
You can synchronise your calendars with other compatible
devices. You can use an existing calendar or create a new
calendar for the events, tasks, and notes.

When calendar events are synchronised, the calendar in the
other device may have more complex settings for repeating
events. In this case, the repeating events are shown in the
device, but the possibility to edit repeating events may be
restricted.

Related topics
• See "Synchronise content", p. 80.

Add the agenda widget to desktop
You can add the agenda widget to the device desktop. With
the widget, you can quickly view your upcoming calendar
events.

Tap the desktop, and select  > Desktop menu > Add
widget > Calendar.

Calendar settings
Select  > Calendar, and open the menu. Select
Settings and from the following:
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Edit calendars  — Add and edit calendars.
Alarm tone  — Change the alarm tone. To add your own
alarm tone, select Add.
Hide done tasks  — Hide your completed tasks.
Delete items  — Define the period after which your calendar
events and tasks are removed.
First day of week  — Change the first day of the week.

Use utilities and manage data

Manage files
About File manager
Select  > More... > File manager.

With File manager, you can move, copy, rename, delete, and
open files and folders.

View files and folders
Select  > More... > File manager.

To view detailed information about a file or folder, select the
item, open the File manager menu, and select Details.

Stored files are compressed to save memory.

You cannot modify read-only files or folders.

If you view File manager files with your PC using a USB data
cable, and Mac or Linux operating system, the File manager
folders are hidden by default. To view the folders, set the
operating system to display hidden folders. In the Windows

operating system, the folders are indicated with extensions
such as .documents, .images, or .videos.

Edit files and folders
1 Select  > More... > File manager.
2 Select a file or folder.
3 Open the File manager menu, and select from the

following:

New folder  — Create a new folder.
Move  — Move a file or folder.
Copy  — Copy a file or folder.
Delete  — Delete a file or folder.
Share  — Share a file or folder.
Sort  — Sort files and folders.
Memory usage  — View memory usage. To view memory
details, select Details.

Memory
About memory
Your device has an inbuilt mass memory with a capacity of
32 GB, some of which is reserved for the device software, and
not available for use when connected to a PC.

In addition to the device mass memory, your device has an
external microSD memory card slot, and it supports memory
cards with a capacity of up to 16 GB. You can insert and
remove a memory card when the device is switched on, if the
memory card is not being used by an application.

90 Use utilities and manage data



Use only compatible MicroSD cards approved by Nokia for use
with this device. Nokia uses approved industry standards for
memory cards, but some brands may not be fully compatible
with this device. Incompatible cards may damage the card
and the device and corrupt data stored on the card.

In case the device memory is corrupted, formatting the device
storage and re-installing the operating system may be
needed.

Manage memory cards
You can create new folders, view memory usage, or move,
copy, sort, share, or delete information from the memory
card using File manager.

1 Select  > More... > File manager and the desired
memory card from the list.

2 Open the File manager menu, and select the desired
action.

Memory 
You can view the amount of available memory in the device
memory, or on the memory card, and the amount of memory
available for installing applications.

1 Select  > Settings and Memory.
2 To view the memory consumption in more detail, select

Details.

To increase the amount of available memory, delete data
using the file manager or other applications.

Increase available memory
Many features of the device use memory to store data. The
device notifies you if the amount of available memory is low.

View how much memory is available
Select  > Settings and Memory.

Increase the available memory
Move data to a compatible memory card (if available) or to a
compatible computer. To remove data you no longer need,
use File manager, or open the respective application.

You can remove the following:

• Images and video clips. Back up the files to a compatible
computer.

• Saved web pages
• Messages in Conversations
• Retrieved mail messages in the mailboxes
• Contact information
• Calendar notes
• Applications shown in Application manager that you do

not need
• Installation files (.deb or .install) of applications you have

installed. Transfer the installation files to a compatible
computer.

Restore the original settings
You can restore all device settings to their default values. This
does not affect content or shortcuts you have created,

Use utilities and manage data 91



security codes, passwords, the device language, or game
scores. Also, it does not affect the contents of the device mass
memory.

1 Select  > Settings.
2 Open the Settings menu, and select Restore original

settings and Yes.
3 Enter the lock code of the device, and select Done.

Use utilities
Read news feeds and blogs 
With the RSS feed reader, you can read news feeds and blogs
from all over the world and content published on different
web sites.

Select  > More... > RSS.

Open a feed
Select the feed you want to open.

Sort feed contents by date or name
Open the RSS menu, select Sort, and the desired sorting
option.

Organise, create, rename or delete folders
Open the RSS menu, and select Manage folders.

Clear all details from the image cache
Open the RSS menu, and select Clear image cache.

Modify RSS feed reader settings
Open the RSS menu, and select Settings.

Open the feed directory to view categorised news feeds
Open the RSS menu, and select Feed directory.

Select from the following:
  — Refresh the view.
  — Add a new feed.
  — View feed details.
  — Delete.
  — Show or hide the folder structure.

View PDFs 
With the PDF reader, you can view documents in the portable
document format (PDF).

Select  > More... > PDF reader.

Open a document
Open the PDF reader menu, and select Open.

Save a document
Open the PDF reader menu, and select Save as.

View the details of a document
Open the PDF reader menu, and select Details.

Select from the following:
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  — Go to the first page of the document.
  — Go to the last page of the document.

  — Go to the previous page of the document.
  — Go to the next page of the document.
  — Zoom in.
  — Zoom out.
  — Switch from normal to full screen mode.

Write notes 
With the Notes application, you can create, save, and send
short notes. Files with the .txt (plain ASCII text with no
formatting) and .note.html (formatted text) file extensions
are supported. The full HTML file format is not supported.

Select  > More... > Notes.

Add a new note
Open the Notes menu, and select New.

Open an existing note
Open the Notes menu, and select Open.

Save a note
Open the Notes menu, and select Save.

Undo or redo an action
Open the Notes menu, and select Undo or Redo.

Change the font
Open the Notes menu, and select Font.

Make calculations 
This calculator has limited accuracy and is designed for
simple calculations.

1 Select  > Calculator.
2 Make calculations.
3 To clear the display, open the Calculator menu, and

select Clear till roll.

Manage certificates 
Certificates are used when creating secure connections in, for
example, web browser and mail. You can install, view, and
delete certificates.

Certificates are used to authenticate the server or the user.
Do not add new certificates unless you have verified that they
are genuine. Adding arbitrary certificates may decrease the
security of your encrypted connections.

User certificates are typically provided to you by your service
provider or company IT department.

Select  > Settings and Certificate manager.

Draw sketches 
Select  > More... > Sketch.
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To draw simple images, start drawing on the screen with your
finger or with the stylus. All sketches are saved in the PNG file
format.

Start a new sketch
Open the Sketch menu, and select New.

Open an existing sketch
Open the Sketch menu, and select Open.

Save a sketch
Open the Sketch menu, and select Save.

Modify canvas size
Open the Sketch menu, and select Canvas size.

Crop a sketch
Open the Sketch menu, and select Crop.

View details of a sketch
Open the Sketch menu, and select Details.

Drawing tools
Select from the following:

  — Draw freehand.
  — Draw straight lines.
  — Draw a rectangle.
  — Draw an ellipse or a circle.

  — Erase a line or shape. Select one of the four brush sizes
from the toolbar, and draw over the area you want to erase.

To change the brush size or colour, select the respective
selector icon from the toolbar.

Play games

Blocks 
The objective of the game is to move and rotate the falling
blocks so that the rows are complete. When a row is
complete, it disappears and the blocks above that row fall
down one row.

Play Blocks
1 Select  > More... and Blocks.
2 Select from the following:

Block speed  — Define how fast the blocks fall down.
Starting density  — Define the number of blocks that
are randomly placed when the game starts.
Starting height  — Define the number of rows at the
bottom of the screen when the game starts.

3 Select Play.

Rotate a block
Tap the block, or press enter on the physical keyboard.

Move a block
Drag the block to the desired direction, or use the arrow keys
on the physical keyboard.
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Pause a game
Select Exit to menu.

Resume a paused game
Select Continue.

Restart a game
Select Restart.

The game is over when the game field is full of blocks, and
the next falling block cannot fit.

Chess 
Play Chess
1 Select  > More... and Chess.
2 Select from the following:

Player 1  — Select black or white game pieces for the first
player.
Opponent  — Select the skill level of the computer
opponent, or select Player 2 for a two-player game.

Sound effects  — Enable sound effects.
Show legal moves  — See all possible legal moves when
moving a chess piece.

3 Select Play.

To move a game piece, drag the piece to the desired location.

When you have successfully moved a pawn to your
opponent's side of the game board, you can promote your

pawn to queen, rook, knight, or bishop according to standard
chess rules.

When the chess game ends, you can return to the game and
undo your last moves.

Undo or redo a move
Select  or .

Pause a game
Select .

Resume a paused game
Select Continue.

Restart a game
Select Restart.

Save a game
Open the menu, and select Game > Save or Save as.

Open a saved game
Open the menu, and select Game > Open and the desired
game.

Mahjong 
The objective of the game is to find matching pairs of game
pieces and clear the whole board as fast as possible. You must
find a pair of identical game pieces that are free to move, that
is, no other game piece is covering them, or lying to the left
and right of them.

Play games 95



Play Mahjong
1 Select  > More... and Mahjong.
2 To define the layout of the board, select Board.
3 To enable sound effects, select Sound effects.
4 Select Play.

When you find a matching pair, tap each game piece with the
stylus to remove them from the board. When you successfully
clear the board of game pieces, you win the game.

Undo or redo a move
Select  or .

Get a hint
Select . If you use a hint, the elapsed game time increases
by 30 seconds.

Shuffle game pieces
Select . If you shuffle the remaining game pieces, the
elapsed game time increases by 60 seconds.

Pause a game
Select .

Resume a paused game
Select Continue.

Restart a game
Select Restart.

View the best times
Select Best times. For each game level, you can view the best
time and the date when it was achieved.

Marbles 
The objective of the game is to match the marbles in the game
area with the pattern and colour displayed on the right side
of the screen.

Play Marbles
1 Select  > More... and Marbles.
2 To define the number of allowed moves on each game

level, select Difficulty level.
3 To enable sound effects, select Sound effects.
4 Select Play.

To move a marble, select it, and drag it with the stylus. You
can move marbles horizontally and vertically. Once a marble
is moving, it only stops when it bumps into a wall or another
marble.

The lower right side of the game board contains the open
chapters and levels. You can play any of the levels in the
current chapter. When you complete all levels in a chapter,
you can move on to the next one.

Undo a move
Select .
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Pause a game
Select .

Resume a paused game
Select Continue.

Restart the current game level
Select Restart.

Restart the whole game
Open the menu, and select Reset > Reset game progress.

Install other games
In addition to the games that are pre-installed in your device,
other games are available for you to install and play. You can
search for and install new games using the Application
manager.

Related topics
• See "Update software and install applications ", p. 82.

Modify settings

Modify personalisation settings
Change themes 
A theme is a set of matching background images, one for each
desktop.

1 Select  > Settings and Themes.
2 Select a theme from the list.

Profile settings 
Select  > Settings and Profiles.

Set the device to vibrate when in the Silent or General
profile
Select Vibrate.

Select the ringing tone and message alert tones
Select Ringing tone, SMS alert, IM tone, or E-mail alert and
the desired tone.

Add a new ringing tone or message alert tone
Select the tone type, Add, the desired tone, and Done.

Select the volume level of tones
Select System sounds, Key sounds, or Touch screen
sounds and the desired volume level.

Adjust the volume of tones
Drag right or left.

Date and time settings 
Define date and time settings
1 Select  > Settings and Date and time.
2 Define the following:

24-hr clock  — Select whether to display the time in the
24 hour format.
Update automatically  — Select whether to update the
date and time automatically.
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Set the date and time manually
1 Make sure the Update automatically check box is not

selected.
2 Select Time zone. Select the desired time zone and

Done.
To search for cities, select .

3 Select Date. Set the current day, month, and year, and
select Done.

4 Select Time. Set the current hour and minutes, and select
Done.

5 Select Save.

Language and regional settings
The language setting determines the language of the user
interface and how the date and time are displayed. The
regional setting determines how numbers and currencies are
displayed.

Define language and regional settings
1 Select  > Settings and Language & region.
2 Define the device language and regional settings.
3 Save the settings, after which the device restarts.

Display settings 
1 Select  > Settings and Display.
2 Define the following:

Brightness  — Drag right or left to change the brightness
of the display. The display brightness is also affected by

the ambient lighting conditions measured with the light
sensor.
Backlight time-out  — Select the period of inactivity,
after which the display is turned off to save power.
Lock screen automatically  — Set the device to
automatically lock the touch screen and keys after a
defined period of inactivity.
Display stays lit when charging  — Set the display to
always remain on when the device is charging.
Touch screen vibration  — Set the display to give a short
vibration feedback when touched.

3 Select Save.

Tip: To save the battery and increase the device operation
time, select a low brightness level and a short time-out
period.

Notification light settings 
Modify the notification light settings
The device notification light can act as status indicator for
device and application-specific events. You can, for example,
set the notification light to indicate that the device is
switched on when the display is off.

1 Select  > Settings and Notification light.
2 Select when to use the notification light, and Save

Tip: To save the battery and increase the device operation
time, turn the notification light off.
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Text input settings 
1 Select  > Settings and Text input.
2 Select from the following:

Hardware keyboard layout  — Define the character set used
in the physical keyboard. Changing this setting may lead to
the physical keys not matching the hardware keyboard
layout.
Use virtual keyboard  — Activate the virtual keyboard.
Word completion  — Enable word completion.
Auto-capitalisation  — Enable auto-capitalisation, to
capitalise the first letter of sentences automatically when
entering text.
Insert space after word  — Insert a space after each
accepted word completion.
1st language  — Select the first language. To select a
dictionary to use for the first language, select Dictionary and
the dictionary language.
2nd language  — Select the second language. To select a
dictionary to use for the second language, select
Dictionary and the dictionary language. When you switch to
the secondary language, the current dictionary for the word
completion feature is also changed.
Use dual dictionaries  — Use both language dictionaries at
the same time.

Modify connectivity settings
Bluetooth settings 
1 Select  > Settings and Bluetooth.

2 Select from the following:

Bluetooth on  — Activate Bluetooth connectivity.
Visible  — Allow your device to be found by other
devices. If your device is hidden (not visible), it can only
be connected to by a previously paired device.
My device's name  — Enter a name for your device. This
name will be visible to other Bluetooth devices.

3 Select Save.

Location settings 
Select  > Settings and Location.

GPS settings
Select from the following:
Enable  — Activate the internal GPS receiver in your device.
The GPS receiver is automatically activated when an
application that uses GPS data is opened.
GPS device  — Select the GPS receiver to use.
Pair new device  — Pair an external GPS receiver with your
device. Select the GPS receiver from the list of found devices.

Network positioning settings
Select from the following:
Enable  — Activate the network-based positioning service
(including A-GPS).
Location server  — Enter the location server address.

Modify settings 99



FM transmitter settings 
1 Select  > Settings and FM transmitter.
2 To activate the FM transmitter, select FM transmitter

on.
3 To select the frequency, select Frequency.

Edit sharing account
Select  > Settings and Sharing accounts. Select an
account and Edit.

Ovi account

Change the password
Enter the new password, and select Save.

Remove the account
Select Delete.

If you are editing the account details using your device, you
cannot change your user name.

Flickr account

Edit account details
Select Edit. Follow the instructions. Return to the account
editing dialog, and select Validate.

Remove the account
Select Delete.

Flickr account details can only be edited using the browser.

Internet connection settings 
You can select which connections are used automatically,
define how often connections are scanned for in the
background, and set the device to switch to a saved WLAN
connection when available.

1 Select  > Settings and Internet connections >
Connect automatically.

2 Select whether you want to use WLAN connections, a
packet data connection, or whichever connection is
available.
To select a connection each time you connect to the
network, select Always ask.

3 Select Search interval to define the frequency of
automatic connection attempts. The default value is 10
minutes.

Switch to WLAN when available
Select Switch to WLAN when available, if you want your
device to use a saved WLAN connection instead of a packet
data connection when such WLAN is available.

Modify phone settings
Modify call settings
1 Select  > Settings.
2 Select Phone > Call and from the following:
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Send my caller ID  — Set your phone number to be
visible to the recipient.
Call waiting  — Activate the call waiting service.
Call forwarding  — Define the phone number to which
the incoming calls are forwarded if you do not answer.
To forward calls to a specific phone number or to a
contact from your contacts list, select Forward to or
Select contact.

3 Select Save.

Network settings
Your device can automatically switch between GSM and 3G
networks.

In the status area, the current network is indicated with the
following icons:

GSM
EDGE
3G
HSPA

To modify network settings, select  > Settings and
Phone > Network.

Select the service provider's network
By default, your device selects the network automatically. To
select the network manually, select Manual and a network.

Select network mode
Select which network to use. If you select Dual, the device
uses the GSM or 3G network automatically, according to the
network availability, parameters, and the roaming
agreements between network service providers.
For further information, contact your network service
provider.

Define data roaming settings
Roaming is based on specific roaming agreements between
your network service provider and other network service
providers, to enable you to use network services outside your
home network, for example when travelling abroad.
Always ask is selected by default. A connection is only
attempted when a confirmation note is accepted. If you select
Always allow, all packet data connections abroad are
handled as in the home network.
For further information and roaming costs, contact your
network service provider.

Modify SIM card settings
1 Select  > Settings.
2 Select Phone > SIM card and from the following:

PIN code request  — Set the device to request the PIN
code when the device is switched on.
PIN code  — Set the PIN code.
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Modify general settings
Modify device lock settings
1 Select  > Settings and Device lock.
2 Define the following:

Autolock  — Select the length of time, after which the
device is locked if not used.
Change lock code  — Enter the current lock code (12345
by default) and the new code twice.

Memory 
You can view the amount of available memory in the device
memory, or on the memory card, and the amount of memory
available for installing applications.

1 Select  > Settings and Memory.
2 To view the memory consumption in more detail, select

Details.

To increase the amount of available memory, delete data
using the file manager or other applications.

TV-out settings 
1 Select  > Settings and TV out.
2 Select PAL (default, used in Europe, for example) or

NTSC (used in North America, for example).
3 Select Save.

Calibrate the screen 
Select  > Settings and Screen calibration, and follow
the instructions.

View information about your device
Select  > Settings and About product.

The available information includes:

• Device model
• Platform name and release
• Software version
• WLAN MAC address
• Bluetooth address
• IMEI address
• Applicable licences
• Other important information about your device

Third party application settings
When you install additional applications, the applications
may automatically add an applet icon to the Settings folder.
By default, the icons are added to the Extras group.

Select  > Settings and the application, and define the
desired settings.
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Open source software notice
This product includes certain free/open source software.

The exact terms of the licenses, disclaimers, acknowledgements and notices are provided
to you in the product. You may obtain the source code of the relevant free and open
source software at http://www.maemo.org/. Alternatively, Nokia offers to provide such
source code to you on a CD-ROM for a charge covering the cost of performing such
distribution, such as the cost of media, shipping and handling, upon written request to
Nokia at:

Maemo Source Code Requests

Nokia Corporation

P.O.Box 407

FI-00045 Nokia Group

Finland

This offer is valid for a period of three (3) years from the date of the distribution of this
product by Nokia.

This software is based in part on the work of the Independent JPEG Group.

The Graphics Interchange Format© is the Copyright property of CompuServe
Incorporated. GIF(sm) is a Service Mark property of CompuServe Incorporated.

Adobe® Flash® Player. Copyright (c) 1996 - 2007 Adobe Systems Incorporated. All Rights
Reserved. Protected by U.S. Patent 6,879,327; Patents Pending in the United States and
other countries. Adobe and Flash are either trademarks or registered trademarks in the
United States and/or other countries.

This product includes software developed by following copyrightholders:

• Computing Services at Carnegie Mellon University (http://www.cmu.edu/
computing/)

• Tommi Komulainen (Tommi.Komulainen@iki.fi)
• The OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org)
• Pedro Roque Marques

• Eric Rosenquist, Srata Software Limited
• The XFree86 Project, Inc (http://www.xfree86.org) and its contributors
• Paul macKerras (paulus@samba.org)
• Purdue Research Foundation
• OpenEvidence Project for use in the OpenEvidence Toolkit (http://

www.openevidence.org/)
• Eric Young (eay@cryptsoft.com)
• Tim Hudson (tjh@cryptsoft.com)

Copyright (c) 1996 NVIDIA, Corp. NVIDIA design patents pending in the U.S. and foreign
countries.

NVIDIA, CORP. MAKES NO REPRESENTATION ABOUT THE SUITABILITY OF THIS SOURCE CODE
FOR ANY PURPOSE. IT IS PROVIDED "AS IS" WITHOUT EXPRESS OR IMPLIED WARRANTY OF ANY
KIND. NVIDIA, CORP. DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOURCE CODE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. IN NO EVENT SHALL NVIDIA, CORP. BE LIABLE FOR ANY SPECIAL, INDIRECT,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOURCE CODE.

Standards
The product is compliant with the following standards:

• EN 301 511, Harmonised Standard for Mobile Stations in the GSM 900/1800 Bands
• EN 300 328, Harmonised Standard for Data Transmission Equipment Operating in

the 2.4 GHz Band
• EN 301 357-2, Harmonised standard for analogue cordless wideband audio devices

using integral antennas operating in the CEPT recommended 863 MHz to 865 MHz
frequency range

• EN 301 489-01, Electro Magnetic Compatibility Standard for Radio Equipment and
Services

• EN 301 489-07, Specific (EMC) Conditions for Mobile Radio Equipment, GSM 900/1800
Bands

• EN 301 489-09, Specific (EMC) Conditions for wireless microphones, similar Radio
Frequency (RF) audio link equipment, cordless audio and in-ear monitoring devices
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• EN 301 489-17, Specific (EMC) Conditions for Wideband Data and Hiperlan
Equipment

• EN 301 489-24, Specific (EMC) Conditions for third generation cellular phones
• EN 301 908-01, Harmonized standard for WCDMA Mobile Station; Common

requirements
• EN 301 908-02, Harmonized standard for WCDMA (UTRA FDD) Mobile Stations
• EN 60950-1, Safety of Information Technology Equipment
• EN 62311, Assessment of Electronic and Electrical Equipment related to Human

Exposure restrictions for Electromagnetic Fields (0Hz to 300GHz)
• EN 50360, Product Standard to demonstrate the Compliance of Mobile Phones with

the Basic Restrictions related to Human Exposure to Electromagnetic Fields
• 1999/519/EC, Council Recommendation on the Limitation of Exposure of the

General Public to Electromagnetic Fields

Please check compliance with other standards separately.

Accessories

Warning:
Use only batteries, chargers, and accessories approved by Nokia for use with this
particular model. The use of any other types may invalidate any approval or warranty,
and may be dangerous. In particular, use of unapproved chargers or batteries may
present a risk of fire, explosion, leakage, or other hazard.

For availability of approved accessories, please check with your dealer. When you
disconnect the power cord of any accessory, grasp and pull the plug, not the cord.

Battery
Battery and charger information
Your device is powered by a rechargeable battery. The battery intended for use with this
device is BL-5J. Nokia may make additional battery models available for this device. This
device is intended for use when supplied with power from the following chargers:
AC-10. The exact charger model number may vary depending on the type of plug. The
plug variant is identified by one of the following: E, EB, X, AR, U, A, C, K, or UB.

The battery can be charged and discharged hundreds of times, but it will eventually wear
out. When the talk and standby times are noticeably shorter than normal, replace the

battery. Use only Nokia approved batteries, and recharge your battery only with Nokia
approved chargers designated for this device.

If a battery is being used for the first time or if the battery has not been used for a
prolonged period, it may be necessary to connect the charger, then disconnect and
reconnect it to begin charging the battery. If the battery is completely discharged, it may
take several minutes before the charging indicator appears on the display or before any
calls can be made.

Safe removal. Always switch the device off and disconnect the charger before removing
the battery.

Proper charging. Unplug the charger from the electrical plug and the device when not in
use. Do not leave a fully charged battery connected to a charger, since overcharging may
shorten its lifetime. If left unused, a fully charged battery will lose its charge over time.

Avoid extreme temperatures. Always try to keep the battery between 15°C and 25°C (59°F
and 77°F). Extreme temperatures reduce the capacity and lifetime of the battery. A device
with a hot or cold battery may not work temporarily. Battery performance is particularly
limited in temperatures well below freezing.

Do not short-circuit. Accidental short-circuiting can occur when a metallic object such as
a coin, clip, or pen causes direct connection of the positive (+) and negative (-) terminals
of the battery. (These look like metal strips on the battery.) This might happen, for
example, when you carry a spare battery in your pocket or purse. Short-circuiting the
terminals may damage the battery or the connecting object.

Disposal. Do not dispose of batteries in a fire as they may explode. Dispose of batteries
according to local regulations. Please recycle when possible. Do not dispose as household
waste.

Leak. Do not dismantle, cut, open, crush, bend, puncture, or shred cells or batteries. In
the event of a battery leak, prevent battery liquid contact with skin or eyes. If this
happens, flush the affected areas immediately with water, or seek medical help.

Damage. Do not modify, remanufacture, attempt to insert foreign objects into the
battery, or immerse or expose it to water or other liquids. Batteries may explode if
damaged.

Correct use. Use the battery only for its intended purpose. Improper battery use may
result in a fire, explosion, or other hazard. If the device or battery is dropped, especially
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on a hard surface, and you believe the battery has been damaged, take it to a service
centre for inspection before continuing to use it. Never use any charger or battery that
is damaged. Keep your battery out of the reach of small children.

Nokia battery authentication guidelines
Always use original Nokia batteries for your safety. To check that you are getting an
original Nokia battery, purchase it from a Nokia authorised service centre or dealer, and
inspect the hologram label using the following steps:

Authenticate hologram
1 When you look at the hologram on the label, you should see the Nokia connecting

hands symbol from one angle and the Nokia Original Enhancements logo when
looking from another angle.

2 When you angle the hologram left, right, down and up, you should see 1, 2, 3 and
4 dots on each side respectively.

Successful completion of the steps is not a total assurance of the authenticity of the
battery. If you cannot confirm authenticity or if you have any reason to believe that your
Nokia battery with the hologram on the label is not an authentic Nokia battery, you
should refrain from using it, and take it to the nearest Nokia authorised service centre
or dealer for assistance.

To find out more about original Nokia batteries, see www.nokia.com/battery.

Taking care of your device
Your device is a product of superior design and craftsmanship and should be treated with
care. The following suggestions will help you protect your warranty coverage.

• Do not use or store the device in dusty, dirty areas. Its moving parts and electronic
components can be damaged.

• Do not store the device in high or cold temperature. High temperatures can shorten
the life of electronic devices, damage batteries, and warp or melt certain plastics.
When the device warms to its normal temperature from a cold temperature,
moisture can form inside the device and damage electronic circuit boards.

• Do not attempt to open the device other than as instructed in this guide.
• Do not drop, knock, or shake the device. Rough handling can break internal circuit

boards and fine mechanics.
• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the

device. Only use a soft, clean, dry cloth to clean the surface of the device.
• Do not paint the device. Paint can clog the moving parts and prevent proper

operation.
• Use only the supplied or an approved replacement antenna. Unauthorised

antennas, modifications, or attachments could damage the device and may violate
regulations governing radio devices.

• Use chargers indoors.
• Backup all data you want to keep, such as contacts and calendar notes.
• To reset the device from time to time for optimum performance, power off the

device and remove the battery.

These suggestions apply equally to your device, battery, charger, or any accessory.

Recycle
Always return your used electronic products, batteries, and packaging materials to
dedicated collection points. This way you help prevent uncontrolled waste disposal and
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promote the recycling of materials. Check product environmental information and how
to recycle your Nokia products at www.nokia.com/werecycle, or nokia.mobi/werecycle.

The crossed-out wheeled-bin symbol on your product, battery, literature, or packaging
reminds you that all electrical and electronic products, batteries, and accumulators must
be taken to separate collection at the end of their working life. This requirement applies
in the European Union. Do not dispose of these products as unsorted municipal waste.
For more environmental information, see the product Eco-Declarations at
www.nokia.com/environment.

Additional safety information
Small children
Your device and its accessories are not toys. They may contain small parts. Keep them
out of the reach of small children.

Operating environment
This device meets RF exposure guidelines in the normal use position at the ear or at least
2.2 centimetre (7/8 inch) away from the body. Any carry case, belt clip, or holder for body-
worn operation should not contain metal and should position the device the above-
stated distance from your body.

To send data files or messages requires a quality connection to the network. Data files
or messages may be delayed until such a connection is available. Follow the separation
distance instructions until the transmission is completed.

Parts of the device are magnetic. Metallic materials may be attracted to the device. Do
not place credit cards or other magnetic storage media near the device, because
information stored on them may be erased.

Medical devices
Operation of radio transmitting equipment, including wireless phones, may interfere
with the function of inadequately protected medical devices. Consult a physician or the
manufacturer of the medical device to determine whether they are adequately shielded
from external RF energy. Switch off your device when regulations posted instruct you to
do so. Hospitals or health care facilities may use equipment sensitive to external RF
energy.

Implanted medical devices
Manufacturers of medical devices recommend a minimum separation of 15.3 centimetres
(6 inches) between a wireless device and an implanted medical device, such as a
pacemaker or implanted cardioverter defibrillator, to avoid potential interference with
the medical device. Persons who have such devices should:

• Always keep the wireless device more than 15.3 centimetres (6 inches) from the
medical device.

• Not carry the wireless device in a breast pocket.
• Hold the wireless device to the ear opposite the medical device.
• Turn the wireless device off if there is any reason to suspect that interference is

taking place.
• Follow the manufacturer directions for the implanted medical device.

If you have any questions about using your wireless device with an implanted medical
device, consult your health care provider.

Hearing aids
Some digital wireless devices may interfere with some hearing aids.

Vehicles
RF signals may affect improperly installed or inadequately shielded electronic systems in
motor vehicles such as electronic fuel injection, electronic antilock braking, electronic
speed control, and air bag systems. For more information, check with the manufacturer
of your vehicle or its equipment.

Only qualified personnel should service the device or install the device in a vehicle. Faulty
installation or service may be dangerous and may invalidate your warranty. Check
regularly that all wireless device equipment in your vehicle is mounted and operating
properly. Do not store or carry flammable liquids, gases, or explosive materials in the
same compartment as the device, its parts, or accessories. Remember that air bags inflate
with great force. Do not place your device or accessories in the air bag deployment area.

Switch off your device before boarding an aircraft. The use of wireless teledevices in an
aircraft may be dangerous to the operation of the aircraft and may be illegal.

Potentially explosive environments
Switch off your device in any area with a potentially explosive atmosphere. Obey all
posted instructions. Sparks in such areas could cause an explosion or fire resulting in
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bodily injury or death. Switch off the device at refuelling points such as near gas pumps
at service stations. Observe restrictions in fuel depots, storage, and distribution areas;
chemical plants; or where blasting operations are in progress. Areas with a potentially
explosive atmosphere are often, but not always, clearly marked. They include areas
where you would be advised to turn off your vehicle engine, below deck on boats,
chemical transfer or storage facilities and where the air contains chemicals or particles
such as grain, dust, or metal powders. You should check with the manufacturers of
vehicles using liquefied petroleum gas (such as propane or butane) to determine if this
device can be safely used in their vicinity.

The surface of this device is nickel-free.

Emergency calls
Before making an emergency call, switch the device on, and check for adequate signal
strength. If the screen and keys are locked, slide the lock switch on the side of the device
to unlock them.

Important:  This device operates using radio signals, wireless networks, landline
networks, and user-programmed functions. Emergency calls can be made using the
cellular phone.It is not possible to make an emergency call using voice calls over the
internet (internet calls). Connections in all conditions cannot be guaranteed. You should
never rely solely on any wireless device for essential communications like medical
emergencies.

Make an emergency call
1 Select  > Phone.

2 Select  and the cellular call type.

3 Enter the official emergency number for your present location.

4 Select  to start the call.

Make an emergency call without entering PIN, PUK, or lock code
1 When the device asks for the code, enter the emergency number for your present

location. The Emergency call icon appears.

2 Select Emergency call to make the call. After the emergency call, you need to
enter the required PIN, PUK, or lock code to be able to use other device functions.

When making an emergency call, give all the necessary information as accurately as
possible. Your wireless device may be the only means of communication at the scene of
an accident. Do not end the call until given permission to do so.

Certification information (SAR)
This mobile device meets guidelines for exposure to radio waves.

Your mobile device is a radio transmitter and receiver. It is designed not to exceed the
limits for exposure to radio waves recommended by international guidelines. These
guidelines were developed by the independent scientific organisation ICNIRP and include
safety margins designed to assure the protection of all persons, regardless of age and
health.

The exposure guidelines for mobile devices employ a unit of measurement known as the
Specific Absorption Rate or SAR. The SAR limit stated in the ICNIRP guidelines is 2.0 watts/
kilogram (W/kg) averaged over 10 grams of tissue. Tests for SAR are conducted using
standard operating positions with the device transmitting at its highest certified power
level in all tested frequency bands. The actual SAR level of an operating device can be
below the maximum value because the device is designed to use only the power required
to reach the network. That amount changes depending on a number of factors such as
how close you are to a network base station.

The highest SAR value under the ICNIRP guidelines for use of the device at the ear is 0.80
W/kg.

Use of device accessories may result in different SAR values. SAR values may vary
depending on national reporting and testing requirements and the network band.
Additional SAR information may be provided under product information at
www.nokia.com.
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DECLARATION OF CONFORMITY

Hereby, NOKIA CORPORATION declares that this RX-51 product is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC. A copy of
the Declaration of Conformity can be found at http://www.nokia.com/phones/
declaration_of_conformity/.

Nokia, Nokia Connecting People, Nseries and N900 are trademarks or registered
trademarks of Nokia Corporation. Nokia tune is a sound mark of Nokia Corporation. Other
product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Reproduction, transfer, distribution, or storage of part or all of the contents in this
document in any form without the prior written permission of Nokia is prohibited. Nokia
operates a policy of continuous development. Nokia reserves the right to make changes
and improvements to any of the products described in this document without prior
notice.

Portions of the Nokia Maps software are ©1996-2009 The FreeType Project. All rights
reserved.

This product is licensed under the MPEG-4 Visual Patent Portfolio License (i) for personal
and noncommercial use in connection with information which has been encoded in
compliance with the MPEG-4 Visual Standard by a consumer engaged in a personal and
noncommercial activity and (ii) for use in connection with MPEG-4 video provided by a
licensed video provider. No license is granted or shall be implied for any other use.
Additional information, including that related to promotional, internal, and commercial
uses, may be obtained from MPEG LA, LLC. See http://www.mpegla.com.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, UNDER NO CIRCUMSTANCES SHALL
NOKIA OR ANY OF ITS LICENSORS BE RESPONSIBLE FOR ANY LOSS OF DATA OR INCOME OR ANY
SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES HOWSOEVER CAUSED.

THE CONTENTS OF THIS DOCUMENT ARE PROVIDED "AS IS". EXCEPT AS REQUIRED BY
APPLICABLE LAW, NO WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, ARE MADE IN RELATION TO THE ACCURACY, RELIABILITY OR CONTENTS

OF THIS DOCUMENT. NOKIA RESERVES THE RIGHT TO REVISE THIS DOCUMENT OR WITHDRAW
IT AT ANY TIME WITHOUT PRIOR NOTICE.

Reverse engineering of software in the device is prohibited to the extent permitted by
applicable law. Insofar as this user guide contains any limitations on Nokia's
representations, warranties, damages and liabilities, such limitations shall likewise limit
any representations, warranties, damages and liabilities of Nokia's licensors.
The availability of particular products and applications and services for these products
may vary by region. Please check with your Nokia dealer for details and availability of
language options. This device may contain commodities, technology or software subject
to export laws and regulations from the US and other countries. Diversion contrary to
law is prohibited.

FCC/INDUSTRY CANADA NOTICE
Your device may cause TV or radio interference (for example, when using a telephone in
close proximity to receiving equipment). The FCC or Industry Canada can require you to
stop using your telephone if such interference cannot be eliminated. If you require
assistance, contact your local service facility. This device complies with part 15 of the FCC
rules. Operation is subject to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation. Any changes or modifications not
expressly approved by Nokia could void the user's authority to operate this equipment.

© 2009 Nokia. All rights reserved.

/Issue 2 EN

111

http://www.nokia.com/phones/declaration_of_conformity/
http://www.nokia.com/phones/declaration_of_conformity/

	Nokia N900 User Guide
	Contents
	Safety
	SWITCH ON SAFELY
	ROAD SAFETY COMES FIRST
	INTERFERENCE
	SWITCH OFF IN RESTRICTED AREAS
	QUALIFIED SERVICE
	ACCESSORIES AND BATTERIES
	WATER-RESISTANCE
	About your device
	Network services
	Shared memory

	Set up your device
	Insert the SIM card and battery
	Insert the memory card
	Charge the battery

	Keys and parts
	Keys and parts (front)
	Keys and parts (back)
	Keys and parts (top)
	Keys and parts (sides)

	First start-up
	Switch the device on
	Start-up wizard

	Kickstand
	Stylus
	Use accessories
	Headset
	Wrist strap

	Introduction
	About Maemo software
	About the desktop
	Application menu
	Status area and status menu
	Status area
	Status area indicators
	Open the status menu

	Dashboard
	About the touch screen
	Touch screen actions
	Touch screen actions in applications


	Basic use
	About your device
	Antenna locations
	Control volume
	Notification light

	Protect your device
	Lock your device
	Change the lock code
	Lock touch screen and keys

	Text input
	Use the physical keyboard
	Use the virtual keyboard
	Switch between input methods
	Switch keyboard layout
	Text input settings 
	Word completion and dictionaries

	Use shortcuts
	General shortcuts


	Personalise your device
	Edit and personalise the desktop
	Profile settings 
	Change the background image
	Change the device language
	Change themes 

	Connect your device 
	About connectivity
	Network settings
	Use a WLAN connection
	About WLAN
	Operating modes
	Create a WLAN connection
	Security settings
	Define advanced settings
	Modify WLAN proxy settings
	IP address settings
	Other WLAN settings
	Modify EAP settings


	Use packet data connection
	About packet data
	Fast downloading and uploading
	Packet data settings
	Advanced settings

	Active data connections
	Disable wireless connections
	Internet connection settings 
	Bluetooth connectivity 
	About Bluetooth connectivity
	Bluetooth settings 
	Pair devices
	Send data using Bluetooth connectivity
	Receive data using Bluetooth connectivity

	USB connections 
	USB
	Use your device as a modem


	Browse the web 
	About browser
	Open and browse web pages
	Browser toolbar
	Organise bookmarks
	Add a bookmark
	Add browser shortcuts to desktop
	Import bookmarks

	Clear private data
	Connection security
	Download files
	Save web pages
	View browsing history
	Install add-ons
	Modify browser settings
	Adjust view
	Web settings


	Organise your contacts 
	Add and edit contacts
	Add and edit My information
	Sort contacts
	Import and export contacts
	Send contact cards
	Add shortcuts to desktop
	Synchronise your contacts
	Contacts settings

	Make calls 
	About calls
	Proximity sensor
	Make voice calls
	Make a call
	Answer a call
	Make a conference call
	Send DTMF tones

	Make internet calls
	Internet calls
	Create and edit call accounts
	Make an internet call
	Answer an internet call

	Options during a call
	Call timers
	Emergency calls

	Send text and instant messages 
	About Conversations
	Send text messages
	Send a text message
	Forward a text message
	Send a contact card
	Save a received contact card

	Send instant messages
	Create and sign in to an instant messaging account
	Send an instant message
	Save and view instant messaging history
	Change avatars
	Change availability status
	Account settings

	Delete messages and conversations
	Filter conversations
	Text message and instant message settings

	Mail
	About mail
	Read your work mail using Mail for Exchange
	Set up your mail
	Set up a Nokia Messaging account
	Set up your other mail
	Set up a Mail for Exchange account

	Read and send mail
	Retrieve and read mail messages
	Create and send mail messages
	Message settings
	Add, save, and delete attachments
	Create a mail signature
	Tips for creating mail messages

	Organise your mail
	Organise mail messages and attachments
	Search within a mail message
	Delete mail messages

	Synchronise with Mail for Exchange
	Modify mail settings
	Mail account settings
	Mail settings
	Nokia Messaging settings
	Mail for Exchange settings
	Configure connection specific SMTP servers


	Capture images and record video clips
	Camera
	Capture images
	Image indicators
	Capture images
	Geotag images and video clips
	After capturing an image

	Record video clips
	Video indicators
	Record video clips
	After recording a video clip

	Change camera settings
	Scene modes
	Image settings
	Video settings
	Flash settings
	General settings

	View images with Photos 
	View images
	TV-out settings 
	Sort images
	Modify images
	Edit tags
	Modify Photos settings


	Share your images and video clips 
	About sharing content
	Create a sharing account
	Share items
	Tags
	Share items using Bluetooth connectivity
	Send items using mail
	Modify sharing settings
	View sharing status
	Edit sharing account 

	Play music and video clips
	About Media player
	File formats
	Add the media widget to desktop
	Search for media files
	Play music with Media player 
	Play music
	Browse the music library
	View playlists
	Add songs to current playlists
	Save playlists
	Shuffle songs

	Use the FM transmitter 
	About the FM transmitter
	Play music using FM transmitter
	FM transmitter settings 

	Play video clips with Media player 
	Play video clips
	Browse the video library
	Add video bookmarks
	Use TV-out to play video clips on your TV
	Play video clips from the internet

	Listen to internet radio with Media player 
	Listen to internet radio
	Add internet radio stations

	Browse media servers

	Find and view locations
	Positioning (GPS)
	About GPS
	Assisted GPS (A-GPS)
	Hold your device correctly
	Position requests
	Location settings 

	Ovi Maps for mobile 
	About Maps
	Move on a map
	Search for a place
	Plan routes
	Maps settings


	Synchronise and transfer content from another device
	Synchronise content
	Transfer data
	Manage transfer details

	Back up and restore data 
	About backups
	Create a new backup
	Restore a backup

	Update software and install applications 
	About Application manager
	About application packages and catalogues
	View log

	Install additional applications
	Browse and search installable applications
	Show installed applications
	Uninstall applications

	Add catalogues
	View, install, and edit catalogues
	Restore application packages

	Check for updates
	Update software
	Automatic software updates
	Software updates using your PC


	Manage time 
	View time and set alarms 
	Add and edit alarms
	View world clock
	Clock settings

	View and manage calendar 
	View the calendar
	Add and edit calendars
	Add and edit calendar notes
	Add and edit tasks
	Add and edit events
	Import events to calendar
	Synchronise content
	Add the agenda widget to desktop
	Calendar settings


	Use utilities and manage data
	Manage files 
	About File manager
	View files and folders
	Edit files and folders

	Memory
	About memory
	Manage memory cards
	Memory
	Increase available memory

	Restore the original settings
	Use utilities 
	Read news feeds and blogs 
	View PDFs 
	Write notes 
	Make calculations 
	Manage certificates 
	Draw sketches 


	Play games 
	Blocks
	Chess
	Mahjong
	Marbles
	Install other games

	Modify settings 
	Modify personalisation settings
	Change themes 
	Profile settings 
	Date and time settings 
	Language and regional settings
	Display settings 
	Notification light settings 
	Text input settings 

	Modify connectivity settings
	Bluetooth settings 
	Location settings 
	FM transmitter settings 
	Edit sharing account 
	Internet connection settings 
	Modify phone settings 
	Modify call settings
	Network settings
	Modify SIM card settings


	Modify general settings
	Modify device lock settings
	Memory
	TV-out settings 
	Calibrate the screen 
	View information about your device 

	Third party application settings

	Open source software notice
	Standards
	Accessories
	Battery
	Battery and charger information
	Nokia battery authentication guidelines
	Authenticate hologram


	Taking care of your device
	Recycle

	Additional safety information
	Small children
	Operating environment
	Medical devices
	Implanted medical devices
	Hearing aids

	Vehicles
	Potentially explosive environments
	Emergency calls
	Certification information (SAR)

	Index


